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For Beginners

Starting something new can be daunting. Learning a skill or
mastering a new piece of hardware is tough. Even tougher if
you have no-one at hand to help. Conversely as the complexity
of our consumer technology increases, the size of the requisite
instruction manual decreases or in some cases it simply
disappears. At numerous times in our lives we have all been
“beginners”, there is no shame in that fact and rightly so. How
many times have you asked aloud, “What does this button do?”.
“Why doesn’t that work?”. “What do you mean it doesn’t do
that?”. “HELP!". At the start of any new journey or adventure we
are all beginners but fortunately for you we are here to stand
beside you at every stage.

Over this extensive series of titles we will be looking in great
depth at the latest consumer electronics, software, hobbies and
trends out of the box! We will guide you step-by-step through
using all aspects of the technology that you may have been
previously apprehensive at attempting. Let our expert guide help
you build your technology understanding and skills, taking you
from a novice to a confident and experienced user.

Over the page our journey begins. We would wish you luck but
we're sure with our support you won't need it.
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macOS Monterey has some awesome new features, and
we’re here to tell you all about them with tip-top tutorials and
plain-English guides to Apple’s latest Mac operating system.
We show you how to set up your Mac out of the box, and get
to grips with its key functions such as Finder, trackpad
gestures and the Dock. With our guides to Monterey’s key
apps you’ll soon be using your Mac like a pro.
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macOS Monterey? —
Older Macs cannot be updated to the new MacBook Early 2016 and later Mac Pro Late 2013 and later
operating system, so if you want to MacBook Air Early 2015 and later Mac mini Late 2014 and later

upgrade your Mac to macOS Monterey, it MacBook Pro Early 2015 and later iMac Late 2015 and later
must be one of the following models: All Apple Silicon Macs iMac Pro 2017 and later
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The Mac Range

Mac mini or iIMac”? Apple Silicon processor or Intel? Big screen or external
monitor? Buying your first Mac can be bewildering but we're here to help. We
bring you a guide to the current Mac models, their strengths and weaknesses
and an outline of their expansion options and range of connectivity ports.

= 4

The new MacBook Air, 13-inch MacBook Pro, and Mac mini are now powered by M1, Apple’s revolutionary chip.

Apple Silicon is Here!

Apple has lifted the lid on the first of its new generation of Mac processors. Let's take a look at why they're a
significant step forward from the previously used Intel CPUs, and are taking the Mac range to the next level.

Apple is changing the processors used in the Mac. Instead of
Intel central processing units, or CPUs, the company is
switching to its own Apple Silicon chips, the first of which is the
M1 processor. It's already unveiled the first computers running
on the new processors. As a CPU is at the heart of a computer,
executing the instructions that make up a software app, this is
very big news indeed.

It isn't the first time Apple has changed the Mac's
processors. In 2006, it dropped the IBM PowerPC processor in
favour of Intel's chips, and before that, the Motorola 68040
series was abandoned for the PowerPC CPUs. Over the next
few years, it makes a change once again as Intel CPUs are
gradually phased out, and are replaced by Apple Silicon
processors. But why? According to Apple, the changeover
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makes Macs faster and more efficient, while using less power,
which is very important for battery life in notebooks. According
to Johny Srouji, Apple’s vice president for hardware technology,
“The first thing this will do is give the Mac a whole new level of
performance.”

Also, as the Apple Silicon chips are based on the same
architecture as Apple's mobile devices, it will be easier to
develop for Macs, iPads and iPhones together, creating one app
that works on all platforms. We're promised Apple Silicon Macs
can run i0OS and iPadOS software natively, and converting apps
from one platform to another is a quick and simple affair.

The first of the Apple Silicon CPU series is the M1 chip, and
on 10th November 2020, Apple lifted the lid on the first Macs
that use it. And they re looking pretty special.




The M1 CPU

Apple is no stranger to designing and manufacturing
processors. It has been making chips for the iIPhone, iPad
and iPod touch for years. But the new M1 CPU, Apple’s
most powerful chip yet, is its first designed for the Mac. The
M1 Is an entire system on a single chip. In the past, a Mac
needed several chips running alongside the CPU. There was
a controller for data transfer in and out, and another for the
Thunderbolt ports alone. Solid state memory required more
chips, as did the Apple T2 for security features. Not any more.
The M1 combines all these technologies into a single unit,
which is great for efficiency, and therefore, performance.

The M1 chip uses five nanometer technology. What this
means is an individual transistor, the things that do the work
In a processor, Is just five billionths of a metre large; the
same size as ten atoms. Smaller transistors makes for greater
speed and efficiency, and also — crucially — it means you can
cram more of them onto a smaller area. The M1 packs in an
amazing 16 billion transistors, the most Apple has ever put on
a chip.

The M1 processor also features the world's fastest CPU
core in low-power silicon, the world'’s best CPU performance
per watt and the world’s fastest integrated graphics in a
personal computer. Clearly designed with notebooks in mind,
a great deal of attention has been paid to keeping power
consumption low, while ramping up its capabillities. As a
result, M1 delivers up to 3.5x faster CPU performance, up to
6x faster GPU performance, and up to 15x faster machine
learning, all while enabling battery life up to 2x longer than
previous-generation Macs.

| DRAM

CPU Fabric GPU
Neural | I |DRAM
Engine
: I
Cache

Unified Memory Architecture (UMA) combines the computer’s memory and its
processor, meaning all parts of the chip can access the RAM quickly and easily.

The Mac Range &

M1 is the most powerful chip Apple has ever created.
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Inside the M1 processor; it packs in 16 billion transistors.

eve these figures? Each M1 chip has
means it can handle aight t’a&&s at once. Four
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cores deliver outstanding f:iﬁffﬂ?“m‘anca at a faﬁfh af the pj, ver.
The other four cores are optimised for efficiency, meaning the
chip is less draining on the battery when doing regular tasks
such as web surfing, word processing and so on.

The M1 also includes an integrated graphics processing unit
(GPU). Featuring up to eight powerful cores capable of running
nearly 25,000 threads simultaneously, the GPU can handle '
extremely demanding tasks with ease, from smooth playback
of multiple 4K video streams to rendering complex 3D scenes.
With 2.6 teraflops of throughput, M1 has the world’s fastest
iIntegrated graphics in a personal computer.

“The M1 ushers in a whole new era for the Mac,” said Johny
Srouji, Apple’s senior vice president of Hardware Technologies.
“When it comes to low-power silicon, M1 has the world’s fastest
CPU core, the world’s fastest integrated graphics in a personal
computer and the amazing machine learning performance
of the Apple Neural Engine. With its unigue combination of
remarkable performance, powerful features, and incredible
efficiency, M1 is by far the best chip we've ever created.”
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The New Mac mini

Apple’s brand new M1 chip boosts the mighty Mac Mini.

As the Macs given to developers to help them convert their
apps to Apple Silicon were based on the Mac mini, it's no
surprise Apple's small form factor Mac is the first desktop to
benefit from the new M1 chip. However this only benefits the
cheaper two Mac minis. The high-end model, with the space
grey housing, still uses an 8th-generation Intel Core 15
processor. Perhaps this model has been retained for those
who need a lot of onboard memory; it can be customised with
up to 64GB of RAM, while all computers that use the M1 chip
are limited to 8GB or 16GB.

There's no holding back the new CPU. It delivers up to 3x
the performance of the previous generation's quad core chip,
and the eight-core graphics processor is up to 6x quicker than
before. Just the thing for playing — and even designing —
graphics-intensive games.

According to Apple, compared to the top-selling PC desktop
In its price range, the mini is one tenth the size but up to five
times faster. We understand Apple used ‘production Intel Core
15-based PC systems with Intel UHD Graphics 630 and the
latest version of Windows 10 available at the time of testing,” but
we're not told which systems.

Machine Learning, the feature whereby software applications
Improve over time by automatically learning as they go, is up to
15X faster than the previous generation of Mac minis, making it
great for ML-assisted photo processing and ideal for scientists,
developers and engineers.

All this extra power hasn't taken a toll on the price. In fact,
the entry-level mini is even cheaper than the previous
generation, costing just £699/$699/778,85 €, but remember, it
doesn’'t come with a keyboard, mouse/trackpad or monitor.

.

The Apple Silicon M1
chip comes to the Mac
mini, but the most
expensive modelin
the range still has an
Intel processor.

When paired with a high-quality 4K screen, the new Mac mini is great for computer-aided design.
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When developing software, compiling code is a processor-intensive task, but the new The Mac mini’s advanced thermal design means the M1 chip can sustain its
Mac mini is more than up to the job. performance while the computer stays cool and quiet.

Suitability. a2 o
If you're keen to see what the new Apple Silicon M1 - k.
chip can do, this is for you. If you need to upgrade a 1 y. 3 4 5 6
Mac mini, there’s no reason not to buy now.
- Ports.
rce. 1 Power Socket 4 HDMI port
Most expensive: Cheapest model:
2 Ethernet port 5 Two USB 3 ports

£899, $899, 1.003,05 € £699, $699, 778,85 €
3 Two Thunderbolt/USB-4 ports § 3.5mm headphone port

www.bdmpublications.com | 9



The Mac Range

Apple’s popular desktop Mac goes from strength

to strength. It's a computer and a monitor, all in
one unit. It's the perfect Mac for the home too.

The iMac is the perfect computer for home and
business use. With the computer, hard drive and
screen all in one unit, you only have one thing to
plug in. Available in 21-inch or 27-inch versions,
all but the cheapest iMac have amazing 4K or
5K displays, for incredible clarity. The iMac’s
only drawback is it's definitely not suitable if you
need to transport it from A to B regularly, but
apart from that, it's great.

Suitability.

The iMac is ideal for the home and
small office user. Unless you need an
incredibly powerful computer, there's
bound to be an iMac that's ideal for
your requirements.

Price.

Most expensive: ; .f
£2299, $2,299, 2.533,45 € s 0000 ™

Cheapest model:
£1,099, $1,099, 1.266,25 €
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IMac Pro

Apple’s pro-level iMac boasts amazing power, but a high price too.

e *y 2. — k.
The iIMac Pro is the same size and shape as the regular 27-inch iMac but ‘ «@%“ J_
under the hood it's a very different beast. It's powered by Xeon processors o :

with up to 18 cores and also boasts a Radeon Pro Vega graphics E'] i : . B

processor. It's the most powerful iMac ever built, by some considerable : INEDESE - —

margin. However, all that power does comes at a price. Even the lowest

cost iMac Pro is very expensive, so unless you really need a lot of

processing power, it's probably not the Mac for you. But if you use your

Mac for a lot of heavy processing work, it's ideal. Stylish, powerful and ’ ' B
expandable, the iIMac Pro is a landmark in computer design, and an
excellent — if expensive — addition to the Mac range. ¥ e
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Suitability.
. | Ports.

The amazing power offered by the iIMac

Pro makes it ideal for video editors, 3D n Headphone socket B Four USB C ports

artists, graphics renderers and music
studios. It's not cheap, but you're B SDXC card reader slot B Ethernet port
B Four USB 3 ports B Power socket

getting a lot of Mac for your money.

Price.
Most expensive (custom built):
£13,499, $13,499, 14.923,15 €

Cheapest model:
£4,999, $4,999, 5.360,35 €
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Mac Pro

Apple abandoned the
unpopular ‘drum’ design
for a new, smaller tower
system. It's the most
powerful Mac ever built!
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The latest Mac Pro is the most
powerful Mac ever built. Based
on a tower design but much
smaller than the last Mac Pro
Tower, this one offers up to 28
cores of processing power,
eight PCI Express expansion
slots, an option for Radeon Pro
Vega || Duo graphics and a
huge range of expansion ports.
You can configure up to 1.5TB
of DDR4 ECC memory in 12
user-accessible DIMM silots,
and up to 4TB of SSD storage.
Naturally, this isn't a Mac for
beginners, but for high-end
Mac users, it's the last word in
amazing computing power.
The ultimate Mac!
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n Headphone socket
3 Thunderbolt 3 ports
B Two USB 3 ports
¥'§ HDMI port

B Two Ethernet ports
B Power socket

: Suitability.

| | ) . .
V9999990 An incredibly powerful computer, but also a very expensive
9SS o one. The Mac Pro is really only for pro users.
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i
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Price.

Most expensive:
£53,299, $53,799, 59.957,90 € (custom built)

Cheapest model:
£5,499, $5,999, 6.335,15 €
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Intel Mac mini

Even with an update to the M1 Chip for the new
mac mini the Intel version still packs a big punch!

Although the Mac mini is the first desktop Mac to adopt the
new Apple Silicon processors, the most expensive model in
the Mac mini range continues to use Intel chips. We
presume this is because the M1 Apple Silicon chip is limited
to a maximum of 16GB of memory, while some users

q @ )

"LLI R | EE\FicE N°] |

require more. This particular Mac mini comes in space grey,
has processors with up to six cores and faster graphics,
providing a significant performance increase. You can opt
for up to 2TB of storage if you buy from the Apple Online
Store too. As there’s only one off-the-shelf Intel Mac mini, for
the most expensive version in the price comparisons, we're
using the online store’s customisation options to max it out.

1
2 Ethernet port

3 Four USB-C ports

4,
5
6

3.5mm headphone

Suitability.

If you need a new Mac mini,
but need more than 16GB of
memory, go for this one. If
you're happy with 8GB or
16GB, buy a new Apple
Silicon Mac mini. Don't forget
to factor in a keyboard plus
mouse or trackpad.

Price.
Most expensive:
£2,999, $2,999, 3.366,95 €

Cheapest model:
£1,099, $1,099, 1.227,25 €

www.bdmpublications.com | 13
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It’s deja-vu all over again with Apple’s latest iIMacs, but there’s much
more to get excited about than just the new colours.

pple’s M1 iMacs are here, and they're
A awesome. Based around the new

Apple Silicon M1 system-on-a-chip
processor, they’re packed with exciting new
features, and like early iMacs from the turn
of the century, they're available in a range
of colours.

The new iMacs are built from the
ground up around the M1 processor.

14 | www.bdmpublications.com

With the entire system on one chip,
the logic board takes up less room,
allowing for a very thin design.

Contrary to several predictions and
concept mock-ups that appeared on the
Internet, they still have a ‘chin’ at the foot
of the screen, albeit without the customary
Apple logo in the middle. In fact, this chin
houses the entire computer, allowing the
IMac to be very thin. When you look at it
from the side, it almost disappears; it’s just
11.5mm thin. Because the entire system

is built into the new M1 processor, the
iIMac needs tar fewer chips, allowing for a
smaller, more compact logic board. And

as it uses very little electricity, it doesn’t
take much cooling. There are two small
fans inside the new iMac, and even at peak
needs, they make less than ten decibels

of noise; that’s almost inaudible to the
human ear.
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Although the new iMacs still have a
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chin under the screen, it’s devoid of

the Apple logo.
- |

The iMac is now available in seven different colours; green, yellow, orange, pink, purple, T

blue, and for those who prefer a more traditional appearance, silver. T

the entirety of the enclosure, front and back, and also its built-in stand.
K and sides of the

stand are a subdued pastel shade for fewer distractions, while the bac
Mac are more vivid. The rear of the iMac displays the traditional Apple
single sheet of glass covers the entire surface
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his colour covers

The front and the

For the first time since 2001, the iMac
is available in a range of colours.

0go. At the front, a

While the previous generation of iMacs came in two sizes,
with 21.5-inch and 27-inch displays, the initial release of
the M1-powered iMacs have just one; a 24-inch screen. The
computer as a whole is only slightly larger than the 21.5-inch
IMac, as the extra screen space is mostly achieved by reducing
the bezel. A 4.5K Retina display, it has 11.3 million pixels at a
4480 x 2520 resolution, and over a billion colours. What that
means for the useris an incredible degree of detail on the
screen. Everything looks really vivid and vibrant. A TrueTone
feature automatically adjusts the picture according to current
ambient light levels, so it always looks natural.

The iMac’s excellent screen is ideal for video editing.
-—s———
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The iMac’s mic, camera and speakers The headphone socket
have also been revamped. The FaceTime is now on the side of
the computer.

camera is now 1080p, double the resolution
of the previous generation’s webcam.

The M1 chip includes Apple’s latest Image
Signal Processor, which further enhances
the image quality. This iMac is great for
video chats. The camera is augmented by a
studio-quality three-mic array, engineered to
reduce feedback from the rest of the system.
The speakers have been improved too.
There are actually six speakers built into the
new iMac; two pairs of wooters and a pair of
tweeters. And it would be remiss of us not
to mention the headphones socket, which

is now on the side of the iMac instead of the
rear, making it much easier to reach.

On the subject of the rear of the iMac, there
are fewer ports than you might expect. The
power socket is now magnetic; it seems Apple
is returning to the MagSate designs of previous
MacBook generations. There are four USB-C
ports, two of which are Thunderbolt 3-capable
for extra-fast data transfer. If you want to use
older USB peripherals, adapters and hubs are
easy to come by. There’s a port for an Ethernet
cable, but instead of connecting to the back of
your computer, it plugs into the power brick for
fewer trailing wires. Note, though, that this port

vou get four USB-C ports, two of is not present in the cheapest new iMac.
which offer Thunderbolt 3 power.

16 | www.bdmpublications.com
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Long-term Mac fans might remember
that when Apple last released the iMacin a - =
range of colours, the keyboard and mouse
colour-matched the computer. The same is
true for the new range. The Magic Keyboard, ——
which is available in a regular version or

with a numeric keypad, features white keys
just like the current keyboards but with their
aluminium housing the same colour as your
chosen iMac, specifically, the softer shade
used for its front and stand. For a controller,
you can choose between a Magic Mouse or

The new iMac comes with accessories
that match your computer’s colour.

Magic Trackpad with details that are similarly

colour-matched. Another optional extra

on the keyboard is Touch ID. This lets you
unlock your Mac, access passwords, make
payments and switch between users simply
by placing a finger on the Touch ID key.
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27-inch iMacs

You can still buy the larger, 27-inch iMacs, but at the time of
writing, they’re only available with Intel chips. They’re

stunning machines, boasting Retina 5K displays, up to
ten-core processors and superb cameras, mic and speakers,
but if you’re keen for the extra screen size, our advice is to
wait; large-screen iMacs with Apple Silicon processors must
surely be on the way.
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Set Up Your Mac
For the First ime

If you have a new Mac but have not yet set it up, follow this guide. It's nothing
to be afraid of; follow the guide and the on-screen instructions, and step by
step, you get to set your Mac's language, take it onto the Internet with your
local Wi-FI network, sign in with your all-important Apple ID and more.

®

Select Your Country or Region

Press the Escape key to hear how to set up your Mac with Voice Over

Press Command-0Option=F5 to view accessibility options

Your first step is to choose your territory, that is, where
you live and will be using your Mac. You can scroll the
list of countries up and down to find your own, or start to type
it to get there quicker. Click your country to highlight your
choice, then click Continue.

®

Accessibility

Accessibility features adapt your Mac to your individual needs. You can turn them on now o help you
finish satting up, and further customise them later in System Preferences. Sea what's available in sach
of the categories below

@

Vision Cognitive

3 If you have a disability that makes it harder to use a
computer, the Mac’s Accessibility tools could be of
interest. If you want to set up your Accessibility settings

now, click one of the buttons. If not, click Not Now — you can

do it later in Settings.

20 | www.bdmpublications.com
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Written and Spoken Languages

The following languages are commaonly used in your region. You can set
up your Mac to use these sattings or customige them indivndually.

@ Preferred Languages
English (LK)

Input Sources
British

Dictation
English (United Kingdom)

Customise Seltings

Now select your language and input source. The
default ones for your chosen territory are offered, but
If you want to change them, click Customise Settings and
set the language your Mac uses and the keyboard layout to
suit your specific needs.

How Do You Connect?

Sekect how your computer connects 1o the internet

'ﬂ Local network (Ethernat)

kiy computor does not connect to the internet

Choose how you want to connect to the Internet. If you
use Ethernet, there’s nothing else to do, but if you use
Wi-Fi, you then need to follow the on-screen instructions on
finding your own network and entering your password. Keep
your router instructions handy:.
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Data & Privacy

This icon appears when an Apple feature asks to use your personal
information

You won't ses this with avery feature since Apple collects this mformation
anly when needed to enable features, secure our services or parsonaliss
WOUF BXperiance,

Apple beliaves privacy is a fundamental human right, 8o évery Appla
product |s designed to minimise the collection and use of your dala, use
an-gdevice processing whenever possible, and provide (ranspafency and
control over your information.

Learn Mora

Next comes the Data & Privacy screen. You're shown
an icon that appears when an Apple feature collects

information, and needs your permission. There’s nothing you

need to do on this screen, just read it for reference and
move on once more.

A <
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Sign In with Your Apple ID

Sign in to use iCloud, tha App Store and ather Apple sendices,

Apple 1D | |

Create new Apphe 1D_.
Forgol Apphe ID or paseword?

Use different Apple IDs tor iICloud and Apple media purchasas?

Sat Lp Later

7 Now it's time to sign in with your Apple ID. If you

already have an Apple ID, sign in now with your
password. If you don't, click the Create New Apple ID link
and follow the on-screen instructions. There's also a link for if
you've forgotten your Apple ID.

Terms and Conditions

Impartant: LUse of your Mac computer, the macDS soltware and related services is subject to these
Terms and Conditions. Please read them carefully,

A. macOSs Software Licence Agresment

Licernce, Warranty and other important product information is seved on your system, and can be found in Aboul This
Mac. The Licence is #to posied at www apphe comjulclegalsla

Back Agroo

You're shown a screen of Terms and Conditions,
which you can read by scrolling if you wish. When
you're ready, click the checkbox labelled ‘| have read and
agreed to the iICloud terms and conditions’, then click the
Agree button in the bottom-right.

[ Set Up Your Mac

&

Migration Assistant

if you have information on another Mac or a Windows. PC, you can transfer it o this Mac. You can also
transfes inforrmation from a Time Machine backup or anather startup disk,

How do you want 1o transfer your information?

O From a Mac, Time Machine backup or Startup disk
From a Windows PC

You're invited to transfer information from a Mac or Time
Machine backup, a Windows PC or not at all. To transfer
data from your old computer, choose the correct option and
follow the on screen instructions. Otherwise, choose the last
option to start afresh.

Sign In with Your Apple ID

Sign in o wse iCloud, the App Store and other Apple services,

A message with & verification code has been sent to your other devices running 05 10 or
macOs Sserra or later. Please enter the cods 1o continue

If you already have an Apple device, a pop-up window
appears asking you to allow the new log-in. Do so, and a
six-figure number is sent, which you must type now. If it doesn't
arrive, click the link under the number fields and follow the
instructions. Otherwise, type the numbers and proceed.

Create a Computer Account

Hill aut the Tollownng nfarmation to create YOUr SOMPULET Bccaunt,

Eull narma: [ | @
|
Account name: L/

Passwiond:

Himil:

Back Contmue

Your account name is based on your Apple ID name but
your password, which unlocks the computer, should be
chosen now. Choose something you can remember and enter
a hint in case you forget. Click the small picture to choose a
different one, or take a photo using the Mac’s camera.
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O

Setting Up Account...

The Mac now sets up your iCloud account on your
computer. This is the screen you see while it's working
things out. You don't have to do anything; just sit and wait. It
takes just a few minutes, so don’t assume it's got stuck ana
try to interrupt or restart it.

Analytics

Help Apple and app developers improve their products and senvices automatically.

T i ADEEe imQrowe S Droducts and senvices, pre-felesse Dels
versions of macOS automatically send diagnostics and usage data
This &80 ba changed i the Sacury & Privacy parss of System
Praferances. Diagnastic data may mclede location information

Aboul Anahytics & Privacy..

13 You can now choose whether you allow analytic

iInformation to be sent to Apple and/or third-party
software developers so they can improve their products. If
you're concerned about privacy, you can decline, but it's
helpful if you agree to share.

Choose Your Look

Select an appearance and see how the Dock, menus, buttons and windows adjust depending on which
o you choosa.

You can change this later in System Preferences.
Auto

Light Diarf
Back Coniinue

the default light look, with white as the predominant
background colour, or dark, with black backgrounds. Auto

switches between light and dark depending on the ambient light.

Choose how your Mac will look when in use. You can go for

Make This Your New Mac

Here's averything sed up as you had it on your olher Meo.

Learm Mome

Locstion Services

a nnﬂ Analytics

n App Analytics

uiin'

Customise Settings Contmue

On the Make This Your Mac screen, you can set up
your Mac quickly, by allowing predetermined settings
to take effect, for things like Siri and Maps. You can
customise these settings by clicking the link; we suggest
you just click Continue instead.

Screen Time

Get insights about your screen time and set limits for what you want to
manage,

Weekly Reports
View dady Snd weekly chafls and et mdkghls aboul wour

wWay irasm the screen and sat dady (me
muts lor BppE OF app calegones

@ Downtime and App Limits
Schaduke Thime s

Content & Privacy Restrictions
Rusinct setings for contacts, explicl content, purchases

and downloads, and privacy

Sereen Time Passcode

L 1 ]
== Manage Scre me for children from your Mac or 1G5

EVicE, O
dEice

Sat Up Lafer Back Continue

You now decide whether or not you want to set up
Screen Time. Click Continue to have Screen Time give
you updates on how you're using your Mac, or the Set Up
Later link at the top to leave it be for now. You can activate it
later in System Preferences.

Amar Yapp

Shut Dewn

Your Mac then sets up, and launches into the lock screen.
Type the password you set up earlier, and your Mac and
Big Sur are ready to use. Congratulations, you've successfully
set up your Mac. We hope you enjoy using it.




Changing Options After Setup

lan Csborme
Apphe 1D, cud, Madi

a B B © Q

é& O I

@ @ «

You can change some of the choices you made while
setting up your Mac by going into the System
Preferences; you can find this in the Apple menu, in the
top-left corner of the screen. There’'s a number of settings
you can change in this way.

Reset to Factory Conditions.

Set Up Your Mac | @8

To change the Analytics option, use the Security &
Privacy pane. Click Privacy and select Analytics &
Improvements to access your options. Other preference panes

that let you change options you previously set up include;

Language & Region, Accessibility and the General pane.

If you acquired your Mac second hand, you might want to wipe it clean and start again. Just follow this guide.

Rostore from Time Machine
L1 ll'I I..|.|.: Ir_ r A & 1t WEngt i i

Erase APFS volumes group “Macintosh HD"7

Thim = & volurs greup, @ st ol volumas containemg macOS and weer
data wohudng the dpsbem volmae “Nacmiosh HO* g tha data
ol “Macinfash HD - Dala® Crascg v group wil parranen by
sraas ol dats siored on s soaameel. Yo can't wendo thes echan

kama:  Macntosh HD
Format:  APFS

First, restart your Mac whilst holding down cmd-Shift-Alt-R; keep
them held until you see the Apple logo, then let go of the keys.
The Mac continues to boot, but instead of the regular desktop, a
window appears showing four options as seen here.

- Ersse “Macintesh HD™1T
Emping "MRacntegh HD® sl pgrrarantty sraes ol dels stoesd on
Yiowd e wrsd Ehie gbicen

ame  Macintosh HD

Format s APFS
APFS (Encrypled)
APES (Case-sersiti
APFS (Case-sersitive, Encrypled)

On the next screen, the Format pull-down menu should read
APFS if it's available or Mac OS Extended (Journaled) if it isn't.
Select the appropriate option and click Erase to wipe your boot
drive. When it's finished, click Done, then quit Disk Utility (cmd-Q).

From the window, select Disk Utility (the bottom of the four

options) and click Continue. Select your startup disk (called
Macintosh HD by default) and in the toolbar at the top of the
Disk Utilities window, click the Erase icon to wipe it clean.

macO0S Monterey beta

To sat up the installation of macOS Monterey bata, click Continue.

Caontinug

Now choose to install macOS and continue. When invited to install
the operating system, do so; you might have to click on the Wi-Fi
icon in the menu bar and rejoin your wireless network. Agree to
T&Cs, select your main drive and click Install to start afresh.

www.bdmpublications.com | 23




B First Steps with macOS Monterey ]

72\ Using Touch ID
(@) On the Latest Macs

Touch ID has long been a stalwart on the iPhone and iPad, but it recently
came to the Mac, with the latest notebook and iMac releases; look for a Touch
ID sensor on the keyboard. You can use Touch ID to unlock your Mac, input
passwords and make purchases, all by using your fingerprint.

Setting Up Touch ID

Apple 1D == Touch 1D

haring

Touch ID lets you use your fingerprint to unlock your Mac and make
purchases with Apple Pay, iTunes Store, App Store and Apple Books.

kEiESIan Siri Spatlight Langiage Rothicatans

e
(i

ion +

Finger 1 Add Fingerprint

...........

Use Touch ID for:

Unlocking your Mac

Apple Pay

iTunes Store, App Store & Apple Books

Password AutoFill

ol Souwnd
Update

& Use Touch ID sensor for fast user switching

hhhhh

First of all, open the System Preferences window. Click If your Mac does have Touch D, to get started, click on
on Touch ID. If this option isn't there, your Mac doesn't the + icon captioned ‘Add Fingerprint’. You can add
have Touch ID as it's a feature on newer Macs. more than one print; here, this is our second.

® £ i1 Touch ID Q

— e S —

iiii Touch ID

Place Your Finger

Place Your Finger

Lift and rest your finger on Touch ID repeatedly. Lift and rest your finger on Touch ID repeatediy.

3 Type your admin password when asked, the one you use Keep raising and lifting your finger. As you can see, the

to unlock your Mac. As instructed, you must now place grey fingerprint in the window gradually turns red, as
the finger you intend to register on the Touch ID sensor, on the Touch ID reads, analyses and records your fingerprint. Keep
top-right of the keyboard. doing this until the centre section is full.




:::: Touch ID

Place Your Finger

Keep going to capture the edges of yvour fingerprint.

Touch ID now needs to cover the edges of your finger.
Continue lifting and placing your finger, but concentrate
on having the edges of that fingerprint on the Touch |ID sensor.

=it Touch ID

Touch ID is Ready

Your fingerprint can be used to unlock your Mac.

The edges gradually build up and go red. Eventually, all
the fingerprint area in the window is red, and you're
told that the registration is complete. Click the Done button in
the bottom-right corner to finish.

3t Touch ID a,

Touch ID lets you use your fingerprint to unlock your Mac and make
purchases with Apple Pay, iTunes Store, App Store and Apple Books.

o ) +

F 1 Finger 2

Use Touch ID for:
Unlocking your Mac

Apple Pay
iTunes Store, App Store & Apple Books
Password AutoFill

Use Touch ID sensor for fast user switching

There's a list of things you can do with your Touch ID
iInstead of typing your admin password. Take a look and
uncheck any that you don't wish to use.

lan Osborne

Unlocking Your Mac

With Touch ID, you can place your finger on the sensor to
unlock your Mac, without your admin password. You still
need the password after it restarts.

Making Purchases

You can use your Touch ID to make App Store purchases.
Buy an app in the usual way, and instead of typing a
password to complete the purchase, use Touch ID.

®@ 9 ©

L &

Amar Yapp  lan Osborne

© Mond4OQOct 11:

Login Window...

Users & Groups Preferences...

Fast User Switching

If two people have accounts on your Mac, and you've enabled
Fast User Switching from the menu bar, you can use your
Touch ID to switch between users too.
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Welcome to the
Vonterey Desktop

The desktop is at the heart of your Mac. Everything you do takes place on the
desktop, including opening apps, interacting with files and folders and using the
Dock. Here we show you how to use your desktop, app and folder windows,
the top bar menu and other key features.

From the Apple menu you
can log out, shut down,
restart or put the computer into
sleep mode, get comprehensive
iInformation on the computer’s
hardware and software, access the
System Preferences and open
items you've recently closed.

The menu bar running along
the top of the desktop gives
access to functions and controls for
the app you currently have open at
the time. The app currently in use is
shown to the right of the Apple icon.
In this case it's Finder. Open or click
on an app and its name is shown
here instead; and its menus are
listed in the menu bar.

3 The Command Centre is where

you can access Bluetooth,
Wi-Fi settings, display brightness,
volume, keyboard brightness, Screen
Mirroring and much more.

Application windows come in

all shapes, sizes and designs.
Your Mac’s applications can be
launched from the Launchpad, the
Dock, from Spotlight or using
Applications window in Finder.

This is a Finder Window. The
Finder utility is the central
point for navigation and file
manipulation. You can browse and
navigate applications, documents,
external drives and even access
other computers; as long as they're
connected to the same network
(cabled or wireless).

26 | www.bdmpublications.com

This is your Mac'’s Desktop.
Click on it to access the
Finder controls in the menu bar.
You can change the picture (or
wallpaper) used for the Desktop in
System Preferences > Desktop &
Screen Saver. ‘The one we have
here Is the standard macOS
Monterey desktop, but there are
plenty of others to choose from,
Including wallpapers from older
versions of macOS.

7 In macQSs, folders work just

like their real-world
counterparts. You can use them to
store files, data and even other
folders. You can call them anything
vou like; click on a folder's name and
type in a new one.

The Dock offers quick and
easy access to your favourite
applications, documents, folders
and even the Bin. It's easily edited
and customised to make the most
of the way you work. Apps you
currently have open are always
shown in the Dock.

You can also put folders in the
Dock, as shown here. Click on
a folder to open it within the dock,
and then click on something inside
the folder to open or launch it.

The Bin, formerly called the

Trash. To delete a file, folder or
application, drag it into here, then
right-click on it and choose ‘Empty
Trash’ from the menu.

Finder

About This Mac

Accounts

8

)i

File

System Preferences...

Edit

View

Go Window Help

App Store... Q Search Maps
Recent ltems >
Force Quit Finder NOHD E{;rk
Sleep Public Transport
Nearby
posiaily, ™ The Stable
Shut Down... 14 mi
) 4" Exeter
Lock Screen AQ  EFooE
Log Out lan Osborne... G #Q <

22 Dropbox (Personal) k
2# Dropbox (Team BDM)

% Setapp A Be
Att

@ AirDrop

@) Recents [

& Applications

(=] Desktop Amg

(% Documents

& Downloads lf’!

iCloud \

¢S iCloud Drive :

=% Shared

= Macint

Locations

"‘. ﬁ: '

5 |



[ The Monterey Desktop ||

Siri.

Date, Time, ——

L__‘ & home hub is responding.

Some things you can

Siri is Apple's Notifications &

personal digital g e

Widgets.

System Preferences
4 “Mlake the screen brighter®

assistant and you can
use it on your Mac.
Just click on this icon

| 1%E Yawtendey 11017 amy
Message Failed to Send
The mossage 1o 011 678 378 failed
o sEndd.

B About this Mac Click on the time here and to open

"How fast is my Mac?” Lomwe Thme Sensitive natifications from

. Meszages an? This aliowrs Mesges to deber

0 the Notifications and Widgets el o P

and a Siri window A “Launch photos : :
opens. See the Siri e sidebar. If you go into System

P : Preferences > Dock & Menu Bar
tutorial for more Messages = : B
. . SLnE IR SO Do and click the Clock option in the
information on how to aanar

sidebar, you can set how the date
spot and time are displayed here.

use this feature.
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Customising the
Monterey Desktop

Although macOS Monterey's default desktop image is very attractive, if you'd
prefer something different, you can personalise your experience by customising
the appearance of your Monterey Desktop. You can choose a new wallpaper
for the desktop image, and even set up a slideshow of your favourite pictures.

Choose New Wallpaper

 SystemProferences Edit  waw  Window  Halp @-Eiqiﬁ;—xﬂumnmm:az

@ D t Q @ = W J &k O Fizase i)

Desktop & Do
Screen Saver Me

,  FEveal

® |

To open the Desktop preferences window, click the Click on the image you'd like to use for your wallpaper. If
Apple menu, select System Preferences and select the there’s a cloud in the corner, click on it first to download
Desktop & Screen Saver option. Select the genre of picture the image. The desktop is updated immediately. Keep it or
required from the left column. choose another one.

Use an Image from Your Photos Library.

" @ System Preferences  Edil

() Favourites

» @ People
y A Shared
| Albums

Open the desktop preferences: Apple menu > System Explore your photo images, and then choose one from the
Preferences > Desktop & Screen Saver. Select the Photos right-hand panel. If it has a cloud in the corner, click this first
item in the directory list, click the chevron to its left to open to download the photo from iCloud. The photo is then used
it. Various options are available. for the desktop. Keep it or choose again.
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Add a Folder to Folders List

iiii  Desktop & Screen Saver

Deskiop Screen Saver

macOs Graphic
Automatic (5]

w Apple
~ Deszktop Pictures

& Colours
v Pholos
Favourites
» (=) People
4. Shared

Open System Preferences and click on the Desktop &
Screen Saver preference pane. In the left-hand column,
click the chevron next to Folders to see what folders are
currently listed in this option.

System Praferances Fdil  View Window  Help @ © § G @ * o J & O Fizase 110

]} = e 0 Moontamparing Paliuies H ]
¥ Diapbox (Pa

% Dwapbosx (Te... = Maunainssrag Pictures

t Setapo £ Pecple used in cur macazines = MAOUMTRIreEnTg 0.0
= Poxio Cagbured Rems W FAouniairsenng 02 o0
B Raxio Cofaried Mams = hMourtairsaing 04505

Anphcations =
- P : Thig W' el B hAourtairsnng 0503

- Moumiasirssing 01.joa

T} Rocents
[= Deskinp
" Documants

(&) Dewnloads

_Il'__'ll:lnl.'l Linwea

=]

Click the “+" icon below the directory list to display a Finder
window. Navigate to a folder on your Mac that contains
pictures you'd like to use for desktop images, select it and then
press the Choose button.

@ System Preferences Edit  View Windo

:iip  Desktop & Screen Saver

Deskiop SraeEn Saer

3 The required folder should now be visible in the Folders
section of the directory list. Click on it and you can
choose pictures in that folder as desktop images. Click on one

to set it as your wallpaper.

[ Customising the Monterey Desktop |

Auto-changing Wallpaper.

syEiem Preterences Edit Wie WIr

52 Desktop & Screen Saver

Desetop SCreen Saver

Mountainesting 06

If you’re using an image from a folder of pictures, you can
have it change automatically after a period of time. Set your
desktop from an image from that folder, then check the
Change Picture box.

Yatem Preferences ot View  Wirdow  Help @ © £t Q = = o L ¥ O Fniidsep
- -'. -
-] £ b Desktop B Scresn Saver
Desktop Screan Saver
_H Fill S&raed B
Apple Bl i - -
B8 (Imsksnp Swiures 1 : .r w-
o Colours i ﬁ r- -j.
LLLLL J - i AL
Fasegr il i "1;.- ] T,
=] Prople -
- Shared g A
el ail Whien lagging in -
Foldws When 'waking from sheap
5 Mowings
£ Mountsn._Pictures . Fwisry 5 aaconds
—_ Fahry minutn
v 1 Fumry 5 miruitos
ok Ewery ‘15 minuies
Lo € Change picture: WEEZSSERE T TN
Random onder Ewery haur

Euwry fiay

With the box checked, the pull-down next to Change Picture
becomes available. You can choose when to have the
wallpaper change to a different picture from the folder;
displayed in order.

YElEm Préfarencss E1

nn  Deskiop B Scresn Saver

Cesktop Scredn Saver

_HI'-'I |

Fit o Scresn
Stredch bo Fll Screen

—
ot | i g "r

f you'd prefer the pictures were used in a random order,
check the box at the foot of the screen. The pull-down
above the pictures lets you choose how the images will fill
the desktop space.
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Gesture Controls
» On Your Trackpad

You can navigate your Mac using gesture controls, just like you do on

your iPhone or iPad. These gesture controls can be performed on a Mac
notebook’s trackpad or on the Apple Magic Trackpad, which is available for
desktop Macs. You can even do a few of them on a Magic Mouse.

=

One of the things that makes the Mac such a pleasure to use is its large and responsive MacBook multi-touch
trackpad or the desktop Mac’s Magic Trackpad. You can use the trackpad in much the same way as you would use
the touchscreen of an iPhone or iPad: to quickly and easily access menus, sort through stacks of pictures or
documents, scroll through documents and to zoom in and out of displayed images. Once you get used to it, you'll find
that it's a very easy and intuitive way of controlling your Mac and that it can do far more than just scrolling.

S ’ 888088080 s

Secondary Clicking. - LT LT LT LTI

. SMODODDDDDNOEEES

Some people like to use a two-button MR EE N
mouse with their Mac, and this can be handy PR e .-

s @

for quick access to shortcut menus by
secondary clicking or right-clicking. To set up
two-finger secondary clicking using the

trackpad, select Secondary Click in the Point &
Click pane of Trackpad preferences. To set up
a one finger secondary click zone in the

bottom left or right corner of the trackpad or \ .'

mouse, select Secondary Click in the Point &

Click pane of Trackpad preferences, and choose Smgle Click
an option from the pop-up menu. Unlike most other trackpads, the entire MacBook trackpad

works the same as the mouse button; and you can click
anywhere on the track pad to activate apps and select icons.

Multi-touch Gestures. f’ ~ Tl ol alalaiataiEl g T
The MacBook’s advanced trackpad supports the - n a - . -
Multi-touch gestures. They might seem a bit complicated at - ﬂ . . n - - - -
first but once you get used to them and have had a bit of AEEERE s

time to practise, they quickly become second nature. Before
long you'll wonder how you ever managed without them.
The trick to using the trackpad properly is to practise using
more than one finger at once. Some gestures use two
fingers, whilst others use three. You need to apply light, firm
pressure and move your fingers smoothly and evenly, all at

E

the same time. Like we said, it takes a little practice but you —
quickly become proficient at it. To enable Multi-touch -
roll Verticall
gestures, view instructional videos of the gestures and set Scroll Vertic y
up various other trackpad options, choose Apple > System Place two fingers together on the trackpad, then move them up
Preferences and then click Trackpad. or down. This will scroll vertically up or down the document or

web page you're currently viewing.
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Zoom In and Out

Two-finger pinching lets you zoom in or out on PDFs, images,
photos, and other large visual documents or web pages. Place
two fingers on the trackpad, then move them apart to zoom in,
or together to zoom out. The quicker you move your fingers, the
more you'll zoom.

-~

-

Access Mission Control

You can access the macOS Mission Control at any time, even
If you've got a full-screen app open. Simply place three fingers
at the bottom of the trackpad and move them quickly upwards
and Mission Control appears.

SlHHBEEAEEDDE8mm
4q

EMEDEPEDEE FEE RS
0 5] ) ) ) ] P o S e

Force Click

The very latest Apple notebooks feature Force Touch
trackpads, which can tell a soft tap from a hard tap. A hard
tap, or Force Click, can be used to preview a file, drop a pin
in Maps, preview a Safari link, rename a file or folder and
more. It's a concept that should prove very familiar to those
who have used the latest iPhone models.

Gesture Controls E

i I - 1
L] [if ] r

- & f 5 : ’ & 2
- | 2 % .:_ '-. 5 -.’ &
EDDEPEDEE
- n . E' " n . . H . - . -

E 'lk A\

s %\
'*f = 1 § q.;
Rotating Images

You can rotate images by placing two fingers on the trackpad
and then turning your hand so that your fingers both move in a
curve. It can be a little awkward on the wrist at first but you'll
soon get used to it. With practice, you wonder how you ever
did without it.

L...-H-.-.-

Switching Between Full-screen Apps

If you've got several apps open full screen at once, you can
quickly flip between them using a gesture. Place three fingers
on the trackpad and quickly slide them to the left or right. This
will scoot the current app aside, revealing the next in line.

& System Proferonces  Edil  View  Wirdew  Helg

Silent clicki

Force Click =

Click then prej
and variable

Turn Off Force Click

If you dislike the Force Click gesture, and find it gets in the
way of your workflow, it's easy to turn it off. Open System
Preferences (under the Apple menu in the top left corner),
and go to the Trackpad pane. Under the first tab, Point &
Click, you see a checkbox labelled ‘Force Click and haptic
feedback’. Uncheck it to turn off this feature.
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Auto

Dark Mode
And Night Shift

If your screen’s too bright, there’'s a couple of great desktop features that
help. Dark Mode inverts the Mac'’s colour scheme, making it much darker,
and Night Shift Mode changes the colour hue, reducing blue light that can
keep you awake if you use your Mac before going to bed.

Dark Mode

Edit  View Wincow  Halp

&  System Preferences @ o § Qg T =B L E © MonliSep 516pm

L ] L4 i Genaral

a 1|
Ligh Dark At

Mmoo Q@ O999 099

Azk o keap changes whan closing documsnts

From the Apple menu, open System Preferences. Click
on the General pane in the top left corner of the window.
At the top, under Appearance’, are the Light, Dark, and Auto
buttons. Dark and Light buttons switch to those modes, and
Auto lets you schedule the changes.

With Dark Mode on, the colours are subdued in Finder,
windows, the Mac's built-in apps and more.
Third-party apps can be updated to take advantage of Dark
Mode too. If you find it more comfortable to work on a dark
screen, this is excellent news.
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Night Shift Mode

Displays

MNight Shift automatically shifts the colours of your display to the
warmer end of the colour spectrum after dark. This may help you

| get a baetter night's sleep.
Schedule: Off i

hdanual: Turm On Until Tomorrow

bEnre W m

tshift 2

From the Apple menu, open System Preferences. Click
on the Displays pane and then on the Night Shift button.

From here you can schedule Night Shift Mode to run from
sunrise to sunset or during custom times; or you can simply
turn it on by checking the Manual box.

Dieplays

wplay prafarences contral the rescilition amnd colowh of sour Bacs displays ard b
\ ent with any nearby Mac or IPad signed in to your Apple 10

MNeght Shift autcmatically shitts (he colours of your cesplay 1o the
warmaer end of the colour spectrom atter dark. This may help you
betier mgni's sieepn

gel a8

Less Waam Rigrs g

With Night Shift Mode enabled, the colour spectrum
shifts from blue to yellow. If you use your Mac late at
night, too much blue light can interfere with sleep patterns,
so using Night Shift Mode when on your Mac close to
bedtime can prevent this.




[ Dark Mode & Desktop Stacks m

Desktop Stacks
For Organisation

If your Mac's desktop regularly gets cluttered with folders, file icons and other
such material that you're currently working on, there’s a solution at hand in
macOS. With a click of your mouse or trackpad, you can organise them into
stacks, grouped according to their file type. Here’'s how to do it.

Your Mac’s desktop often fills with files and folders you
know you need regularly but that can mean a very

cluttered workspace. To use Desktop Stacks, first click on
the desktop to make sure Finder is active, then click on the
View menu in the top bar.

Q. T W g & © Sat20c 1208pm

0.5

QUMESIEErng Mouwntameerin

OE.jpg

3 To open a stack on your desktop, click on it. The items

contained in that stack are revealed, allowing you to
access and open individual files. To close a stack again,
click on the down-pointing triangle icon that replaced the
stack when you clicked to open it.

@ O 35 Q 8 T M & & O Suz0u 1203pm

From the View menu, select the Use Stacks option.
Your files are stacked on the right-hand side of your
desktop, according to their type. For example, images are
stacked together, as are documents. To turn this off again go
to View and click Use Stacks.

_Miew  Go  Window Help B R $ ¥ O th < ®@ O £+ Q @ T ™ U = O 520 12088

imagoes

......
P!

You can choose how you group your stacks. In View,
go to Group Stacks By and then pick an option. If you
use finder tags (see later in this book) to identify files from
the same project, for example, grouping by Tags keeps
them together and easier to find.
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Getting Online
With Wi-FI1 or Ethernet

As is the case with any modem operating system, access to the Intemet is a
vital component for upgrading and getting hold of new apps that will help you
get the most from your Mac. Getting online in Monterey is remarkably easy and
here’s how to do it both wirelessly and with a cabled connection.

Connecting with Wi-Fi
© 3 Q @) & 88 ©

Make sure that your Mac is within range of your wireless
router's Wi-Fi signal, then click on the Wi-Fi icon in the

top menu bar. You'll see a list of Wi-Fi networks. If your Wi-Fi is
off click the switch to turn it on.

H The Wi-Fi network “House_of_Felix" requires a
ey, WPAZ password.

' You can alzo access this Wi-Fi network by sharing the
password from a nearby iPhone, iPad or Mac that has
connected to this network and has you in their contacts.

Fassword: | e*essssssssssssss

Show password
Remember this network

3 If a password is required (it probably is), a window

appears. Enter the password here. If you're setting up at
home, the password is probably supplied with your router, Your
Mac then joins the network, and remembers it so you don't have
to add the password every time you go online.
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Wi-Fi C
Personal Hotspot
@ iPhone (2) il 4G )
Other Networks o
% House_of_Felix w
'+ SKYNFUPA 8
= smithsl -
= smiths1_EXT B
= Virgin Media ™
- VM1842494 el
< VM3935139 =]
= VM7625092 @

Other...

You'll see a list of Wi-Fi networks available in your area.
A lock to the right shows a password is required to join

it. Click on the network you wish to join, whether it's your own
router or a public Wi-Fi in a cafe or bar.

Using Public
Wi-Fi.

Some high street locations
such as libraries, bars and
restaurants offer free Wi-Fi
to their customers. There
are many different ways you
can access public Wi-Fi.
Some locations may have
an unsecured connection, |
some require you to ask for |
their Wi-Fi password, and

for others you have to register via their pop-up website;
just open Safari while in such a Wi-Fi zone and then

follow the on-screen instructions that appear when your
Mac connects to the network.




Configuring Your Wi-Fi
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Click on the Wi-Fi icon in the top bar, and in the menu
that is shown, click Network Preferences at the bottom.
The System Preferences window appears, with Network
Preferences already open. Click the Advanced button.

& Systom Preferences Edit  View Window  Halp @ T £+t a8 T A ¥

MNalwork
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Change networks

Turn 'Wi-Fi ani or aff

Wi-Fi MAC Address: 80006 37 ec-bd:81

You can see a list of all the Wi-Fi networks your Mac
has connected to, in order of preference. Where two
networks are available, the higher one is used. If you want to
change this order, simply drag and drop them.

System Preferences Edit Vew Window  Help @ © 3 A8 F = L E C

Matwark
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In the TCP/IP tab, you're able to see what IP address

your Wi-Fi router has allocated to your Mac; handy if you
ever need to connect remotely from another computer. You can
also edit these settings and create your own, static I[P address.

3

[ Getting Online = &

Going Online with Ethernet.

If you prefer the stability and speed offered by a
cabled, Ethernet connection, here’s how to set this up

~,

Once you've set up your router according to the instructions
supplied with the device, getting online using Ethernet is
relatively easy. First of all, you need a cable that looks like
this. There should be at least one supplied with your router.

Plug one end of the cable into your Mac and the other end
into one of the router’s Ethernet ports: it doesn’t matter which
one. If your Mac doesn'’t have an Ethernet port, you need an
adapter. You can get one online or from an Apple Store.

-~

If your router isn't close .|
enough to your Mac to

support a cabled ’ J
connection, consider

using Home Plug AV /
instead. This uses your ,
household electrical [ 3
wiring to send data. o
Ask at your local [ J

computer store about a
Home Plug AV starter
kit. There are many
different brands of
HomePlug AV devices
to choose from, and as
HomePlug AV is an
industry standard,
they’re all compatible

with each other.
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Monterey’s Menus
A Key Mac Feature

Whether it's a pull-down menu accessed by clicking on the top bar of your
desktop or a contextual menu found by right-clicking or ctrl-clicking on a
file or folder, you need to know how to use your menus if you are to get the
most out of your Mac and Monterey. Here's a guide to your Mac’'s menus.

The Apple Menu

1 The Apple menu is

About This Mac shows 3 The System
found in the top left

you technical information Preferences option

corner of the desktop. To about your computer. Tabs at opens the Mac’s System
open it, click on the Apple the top of this window let you Preferences, which we

icon once, then choose an delve further, looking at its discuss later in this book.
option. It's always there, Display, Storage and more; you

whatever it is that you're can get a full report by clicking This option opens the

doing on your Mac. the System Report button. App Store. If updates

)@ Finder File Ed i Go Window Help ® O 2 Qo
About This Mac
Systmn Preferences...

Arp - 4 | Applications
Recent Items L Show “App Store” in Finder m
... | . Show “FaceTime" in Finder
& Show “Finder" in Finder
&« Show “Maps” in Finder
~ Show “Preview” in Finder
@ Show “Safari” in Finder
>/ Show “Secrets” in Finder
- @ Show “System Preferences” in Finder
. Show "Toast 20 Installer” in Finder
@ Show “Toast 20 Pro” in Finder

' Show “Customising Desktop, Page 1, Use Image from Photos Step 1 Guide” in Finder
 Show “Customising Desktop, Page 2, Add a Folder Step 1 Guide" in Finder
' Show “Customising Desktop, Page 2, Add a Folder Step 2 Guide" in Finder
stomising Desktop, Page 2, Auto-Changing Step 1 Guide" in Finder
ising Desktop, Page 2, Auto-Changing Step 3 Guide" in Finder
ne, Page 1, Configuring Wi-Fi Step 1 Guide" in Finder
je 1, Connecting with Wi-Fi Step 1 Guide” in Finder

LLoLE
e _ "'_.--#"' Lo b’}
o ey it e
|T-rl'."_"'-'|:—;'="'"'-'h iy o Y
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are available for your Mac or
any of its apps.

Hover your pointer over
the Recent Items option
to see the sub-menu showing
apps, documents and servers
you've recently used.
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Click here to restart
your Mac. This is useful
If you've installed new
software or your Mac isn't
behaving as it should.

Click here for the Force
Quit window. This
window lists all currently open
applications and notes if any
of them are unresponsive,
that is, they've crashed. You
can force a crashed app to
quit from here.

Click to shut down your
Mac, that is, switch it off.

7 Click here to put your
Mac into Sleep Mode.
This saves energy and
password-protects your Mac
while you're away from your
keyboard for any time.

Lock screen brings up
your password screen.
You have to enter your

password to continue to use
your Mac. It's useful if you're
leaving your Mac for a while.
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Open With >
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|=—— mem Copy — = ———
; C Share >
g e s
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ipg 1 16.jpg 16.jpg
Quick Actions >

tosh HD » Bl Users Sand with Transfer (Team BDM)
E Sand with Transfer {Personal)
3 Move to Dropbox (Team BDM)
E Move to Dropbox (Personal)

Services

Contextual Menu

Files and folders have a Contextual Menu that you can access
by right-clicking or ctrl-clicking on the item, or clicking with two
fingers on a trackpad. This menu gives a range of options,
which change according to what it was you clicked on. There's
usually a Share and a Move to Bin option in there, and the Get
Info option brings up an information window.

Right-clicking and ctrl-clicking.

[ Monterey’s Menus [

Click here to log
yourself out but not
shut down your Mac. This is
useful if you have more than
one user account on your
Mac. You can then log out so
another user can log in.

By hovering over the
Recent ltems option,
you get this sub-menu. This is
a list of the applications
you've recently used. Click on
one of them to open it again
rather than use the Dock.

These are the
documents you've
recently used. If you need to
open one again, this menu is a
quick and easy way to do so.

14 Servers you've recently
accessed on your
wireless or Ethernet network
appear here. To open one
again, simply click on it.

15 Click here to completely
clear the entire Recent
ltems sub-menu.

@ Preview Flle FEdit View Go Tools Window  Help

New from Cliptosmd

Dpen Recent ¥
Close Windaw

mmm O B
Save M5

Application Menus

1]~ Mountaineering 0Z.jpg

® © 2 a e T = &

Each application has its own unique set of menus located next
to the Apple menu. They will change when an application is
active and will revert back to the Finder menu when no apps
are active. Each is clearly labelled to make it easier. We'll add
specific details for application menus when we |look into the

applications themselves later.

Mac mice and trackpads only have one button, so how do you make a right-click? It's actually easier than you think.

ﬁ lan Osborne a
m":,","-‘- Appde 1D, iClowd, Medis & App Sore ey
. o B RN © Q .
"-:f:-:.-'.-."l g
I L-oftio 1| Lalg]
@ © I w @
Accassibilily Sc & Exlansaons

@

MTES for Mac

Your Magic Mouse or Trackpad doesn’t have two buttons,
but you can still secondary-click by holding the Control
(ctrl) key and clicking your mouse or trackpad. Alternatively,
enable right-clicking. Go to Apple menu > System Preferences
> Mouse/Trackpad, depending on which you're using.

it Trackpad

Point & Click  Scroll & Zoom  More Gestures

Look vp & data deteciors
Fores Cliek woih orve firgar

B CE

Secondary click
Click with bes fingers s

o Chck with ved Tegers
Chek ir botieem rght corner
Tk im Bnbleem sl car s

Click Trackirg speed

gt bledum  Fir S

Silont clcking
Force Click and haptic feadback

| |
B |

& m"\.

DISTRICT

Sét Up Blustooth Trackpad.., ?

Click the checkbox for Secondary Click. There are also
a few other options here such as click weighting. With

Secondary Click activated, clicking on the right side of a
Magic Mouse or with two fingers on a Magic Trackpad is the
equivalent of right-clicking on a two button mouse.
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. Using Finder
Files, Folders & Apps

Finder is the main app that underpins everything you do in macQOS, so it's worth
taking the time to discover its features and functions. On these pages you'll

see how Finder works and how you can use the Finder window; including its
navigation controls, viewing tabs and more, to get the most from it.

Window Control Options: Use the gumdrops to
close or minimise the window or open it in full-screen
mode. We'll cover this on the next page.

Navigation Controls: The chevron buttons in the
top left corner of the window take you forwards or
backwards through your navigation history.

3 View Options: These four buttons let you set-up

how you view the files and folders in the Finder window;
whether as icons, a list, in columns or as a cover flow which
gives you a much larger visual preview.

3 setapp
@3 AirDrop
@) Recents

A Applications

Mountaineering Mountaineerin

=] Desktop ; :
0ipg 02.jpg

™ Documents

(%) Downloads Lt _ .

Mountaineering

% iCloud Drive

Mountaineering
04.jpg 05.jpg

Item Arrangement List: Click on the button shown
here to order the contents of the window; according to
date, alphabetically and more.

Share Button: The Share button is found in many
places throughout macOS. Here you can highlight a file
or folder and click the button to send it by email, AirDrop etc.

Tags Button: You can tag a file or folder to make it
easier to spot or group it with other documents and
folders. An item can have more than one tag. Click on a tag in
the sidebar to show items labelled with that particular tag.

Mountaineering

=% Shared

& Digital Media
&~ Kingston 8GB
] WDMyCloudEX2

@ MNetwork

® Grey
@® Purple
@ Green
® Red
® Gray
Yellow

@ Blue
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7 Perform Tasks and Search: The Perform Tasks

icon enables you to perform certain tasks within the
folder or highlighted file, such as create a New Folder, Move
to Bin, Duplicate and more. Next to this is the Search bar. If
you're looking for a specific item, type its name or contents
into the Search field and press Enter.

Sidebar: There are various options on the Finder
window'’s sidebar. You can open specific folders like
Documents or Downloads, access external or network drives
and more. To hide and show the sidebar, use the View menu
to toggle it on or off or enter ctrl-cmd-S.

Displaying a Finder Window

There are several ways of opening a new Finder window
on your Mac’s desktop. Let's take a look at each in turn.

@ Finder File Edit View Go Window Help

New Finder Window af

New Folder O %N
New Folder with Selection A% N
New Smart Folder

New Tab 3 1

Open & 0
Open With >
Close Window 3 W

Using Menus

Click a clear space on the desktop once, open the File menu
and select New Finder Window. A window then appears.

Shortcut Keys

Click a clear space on the desktop once to make sure
you're in Finder, then press cmd-N together. A new Finder
window appears on the desktop.

Using the Dock

If it isn't already displayed, move your mouse cursor to the
bottom of the screen to open the Dock. Click the Finder
Window to create a new window.

Window Controls Options.

The coloured buttons, or gumdrops, are found in the top left
corner. Hover over them and a symbol appears in each of them.

Close
Click once on the red button containing
. a cross. This will work with the majority

of windows and applications.

Minimise

Click the orange button containing a ‘-

sign. Again this will work with almost all
] windows and apps.

Full Screen

Click the green button with two triangles.
. This will full-screen most windows.

Using the Finder | &

File/Folder View: This shows the files and folders
contained in the currently open folder. They're shown in
the format chosen in the View Options (see feature number 3).
Here, as you can see, we've gone for the icon view.

Preview: This is a preview of the currently selected
file in the main window. It shows the title, file size and
various details about it. There are also options at the foot of
the Preview sidebar, such as rotating or marking up a
graphic or creating a PDF from a document. The preview
sidebar is optional but useful; you can close it in the View
menu or by pressing Shift-cmd-P

How to Relaunch Finder

If the Finder has crashed or isn't behaving as it should,
follow this tip to close it like a crashed app and relaunch it.

i Finder File Edit View Go Window Help

About This Mac

System Preferences...
App Store...

Recent Items >

Force Quit Finder THHEY

Sleep
Restart...
Shut Down...

Lock Screen ~8Q
Log QOut lan Osborne... G HQ

If the Finder crashes, you can relaunch it like you would with any
other crashed app. The easiest way to do this is to click on the
desktop to make sure you're in Finder, hold down the Shift key
and click on the Apple menu. The Force Quit option has
become Force Quit Finder. Incidentally, you can use this method
to quit any running app. Just click on one of its windows to bring
it to the fore, hold Shift and click on the Apple menu.

Navigation Controls.

These simple controls allow you to retrace your steps
backwards and forwards through Finder.

(Fr—— | Navigate to a
Previous Page
> Click the left hand arrow. To

continue stepping backwards,

Back/Forward| repeat step one as many times
as necessary.

— 1 Using the Forward Control
If you've moved to a previous page,

< @ this button offers step-by-step
navigation to your original starting

point. Simply click the right-hand

Back/Forward .
arrow as many times as needed.

e -
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View Options

i Filie Edit View Go Window Help
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View Window Contents as Icons

To display your files and folders as a collection of icons, first
open a Finder window then click the first button on the toolbar,
showing a group of four squares.
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View Window Contents as Lists

With an open Finder window, click the second button on the
toolbar to use a simple but effective list display.
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View Window Contents as Columns

Click the third button on the toolbar to view your files as a
series of columns. It's great for quick navigation and easy
visual identification using a handy image preview column.
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View Window Contents as Gallery View

The Gallery View gives a large preview of the file or folder that's
currently selected and a scrollable strip of everything else. Click on
one of the files in the strip to see a larger version of its thumbnail.
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Change the Way Items
are Arranged.

As well as changing the way the items are displayed, you
can also change the way they are arranged.

Date Last Opened

Name: Alphabetical. Displays numbers first, then A-Z.
Kind: This groups each type of item together.

Application: Groups together items according to the
application in which they were created or are opened.

Date Last Opened: Groups according to time and
date they were opened.

Date Added: Displays items in order of when they
were added to the folder.

Date Modified: Displays items in the order they were
last modified or edited.

Date Created: Displays the items according to when
they were created.

Size: Arrange the files according to their size.

Tags: Files are arranged according to tags you've added



More Sidebar Functions.

If your sidebar is getting cluttered, you can show or hide its listed
items by hovering over the title (Favourites, Locations, iCloud, Tags)
and clicking the small down-facing chevron or right-facing chevron
— the right-facing chevron appears when the title is hidden, and the
down-facing chevron when they're expended. You can also eject
external drives, CDs and disk images from the sidebar; by clicking
the eject icon next to the device or image you wish to remove.
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Click on the three dots within a circle icon (next to the
Search Bar) for a drop-down menu. Here you can do a
range of operations, from opening a highlighted file in a specific
application to checking the file size via the Get Info option.

The Finder’s Preview Panel.
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Finder windows have a right-hand sidebar that shows a preview
of the currently selected file from the window. You can turn this
sidebar on or off in the View menu (Hide/Show Preview) or press
Shift-cmd-P on the keyboard.
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You can also clean up the entire Finder Window,
automatically tidying up and or reorganising the order of
the files according to various criteria such as their name
(alphabetically), date, size and more.
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Customise...

At the foot of the preview sidebar are a set of new options.
These vary according to the type of file you're previewing in the
main window. For example, an image can be rotated, annotated
or converted into a PDF.
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Full-screen Mode

If you want to view the Finder window better or any other window for that matter, then you can always opt to view it in
full-screen mode. Full-screen removes distractions and makes everything a little easier to read. Here’s how it works.
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You can view a Finder window and indeed an application
window, in full-screen mode. Click on the green Enlarge
button in the upper left corner of the window and it gives you
the option to expand to fill the entire screen. Alternatively, use
the View pull-down menu or press ctrl-cmd-F
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In full-screen mode, the menus usually found at the top
of the Mac desktop are still there but they're hidden
away until you need them. To see them, move the mouse
cursor to the top of the screen and the menu bar slides into
view and disappears when the cursor is moved away.
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3 To exit from full-screen mode back to the usual window

view, bring up the Menu bar and then simply click on the
green button again. The window shrinks to its previous size
and no longer takes up the entire desktop.

32-Bit Apps No Longer Run.
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You can also take a window out of full screen mode
using the View pull-down menu at the top of the screen
or by pressing ctrl-cmd-E You can still close a full-screen
window with the red button (top left).

Apple has phased out support for applications built for 32-bit architecture. These will no longer run in macOS.

Chess CleanMyMac X CloudMounter Contacts devolo
% .E
Font Book GoodLinks
(== ke -
BB
1
iIMovie Kaspersky Keynote Launchpad Mactracker

Internet Securitv

In macOS Monterey, you can no longer open applications made
for older 32-bit processors (modern processors are 64-bit). If you
have such an app on your Mac, it appears in the Applications
window, or Launchpad, with a crossed-out icon atop it.

42 | www.bdmpublications.com

. L ] L= =y Gl TETET TRy T = R
B @ . -
n Utilities Chess r Contacts
"Flow" needs to be updated.
; . The developer of this app needs to
o — update it to work with this version of AA
>4 mac0S. Contact the developer for more
. infarmation. '
bpbox Facelime Learn More oK Font Book G
= b = =) .- l

Try to open a 32-bit app and you get a message saying it's
not compatible with this version of macOS. Check with its
developer whether the app has since been updated to 64-bit,
but if it hasnt by now, it might well have been abandoned.



Changing the Finder Window’s
Background Colour or Image
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When you're using the Finder's Icon View, you can replace
the white background with a coloured one or even a
picture. To begin, with the Finder window in question open,
select Show View Options from the View menu or press cmd-J.
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The window’s Info window opens. Towards the bottom, you
can see options listed under the header ‘Background'.
Select ‘Colour and click on the white square. You can now use
the various options to change the background colour.
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3 Select ‘Picture’ and then drag an image into the box to
the right of the background options to get a pictorial
background. Alternatively, click on the box and then navigate to

the picture you want to use through the Finder.

[ Using the Finder &

Accessing iCloud Drive.

iCloud Drive can store and share files across Mac or iOS
devices logged into the same iCloud account.
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Click on iCloud Drive in the Finder window’s sidebar. You
see the iCloud Drive folder is organised according to apps.
You can create your own folders here too.
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Files and folders found here are synced using iCloud Drive,
so they’re available online at www.icloud.com and also on
other devices linked to the same iCloud account.
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Here we’ve opened the Pages iOS app on an iPad. As you
can see, the documents in the Mac’s Pages iCloud Drive
folder are also available to open and edit here.
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Monterey’s Dock
asd For Most-used Apps

The macOS Dock is a feature that greatly speeds your workflow. It's perfect
for gaining quick access to the most relevant and frequently used applications,
documents and folders. It's customisable too, which means you'll come to
personalise your Dock to best fit your own unique needs. Here’'s how it works.

Accessing Your Applications from the Dock

Add or Remove an Application Move an Application

To add an app, first click the icon filled with multicoloured To move an item to a new location in the Dock, click and
poxes on the left-hand side of the Dock to bring up drag to the required position. As you move the item the
_aunchpad. Then, click and drag the item you want onto the adjacent applications will move aside to allow you to drop
Dock. To remove it, just drag it out. the icon into its intended place.

Open an Application Recently Used Applications

To open an application that's in your Dock, simply move the Applications you've recently used are shown in their own
mouse pointer onto the Dock and click on its icon. Notice section in the right-hand side of the Dock, from where they can
that the app icon slightly bounces as the application opens be used like any other Dock app. A divider separates

before the main app opens. permanent and recent apps.
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Adding and Removing Stacks

You can add, remove and move folders in your Dock, in the
same way you do with apps. These sit to the right of the
Dock’s second divider and are called Stacks.
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Accessing Stacks

To access the files and folders within a Stack, click on it to
display the contents. Clicking on a document or image
opens it with an appropriate application and clicking on a
folder opens it in Finder.

o Mamea
Date Added
Date Modified
Date Created
Kind

PRPAEY |
Faldar
» Stack

View contant ns

Grid

Viewing Options

Right-click or ctrl-click on a Stack for a pop-up menu with a
range of options. You can show your files as a Stack (a pile of
files) or as a folder. You can also choose how they're displayed
when you click the Stack.

The BIin.

[ Monterey’s Dock B

The Bin icon is located at the far right of the Dock and
can be filled and emptied just like a real rubbish bin.

Mountaineering
16.jpg

You can delete a file, folder or app by dragging it into the Bin
on the right-hand side of the Dock. Alternatively, right-click or
Ctrl-click on it and select Move to Bin from the contextual

menu that appears.

Open

Empty Bin

To retrieve a file from Bin, click on the Bin icon in the Dock
to open it in Finder, then drag the file out of the Bin window.
To empty Bin, right-click on it and choose ‘Empty Bin’, or in
the Bin window, click on the Empty button (top right).

Customising the Dock.

You can customise your Dock in System Preferences from
the Apple menu and selecting Dock & Menu Bar. From
here, you can place the Dock on the right, left or bottom of
the screen, opt to show and hide it, change its size, change
its magnification, choose a minimisation effect and more.
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® Notifications
-~ See What’s Going On

Apps and functions on your Mac can send you notifications, which let you know
what's going on. \When you receive a message or an email, for example, you
can get a notification telling you that it's arrived. You can customise them too.

® Finder File Edit View Go Window Help

B

If you came to
Monterey from a
pre-Big Sur version
of macOS, you might
look for the
Notification Centre
icon in the top-right
corner of the screen.
However, it's not
there. Instead, Apple
has integrated
Notifications into the
Date/Time and
Widgets zone.

------ = e T

L3

Moving notifications to the Date and Time and combining them
with widgets is a clever move on the part of Apple. All you need to
do to view your notifications is to click on the Date and Time in the
top-right of the desktop. If there are any, they appear at the top of
the slide-in area that appears from the right-side of the screen.

Notifications are grouped together depending on the app
they're coming from. For example, the News app displays
notifications based on what news channels you've decided can
send alerts to you. If you click on a notification in the group, the
rest expand so you can see all the available notifications of that
group. And clicking on a notification, whether it's from
Messages, News and so on, opens up the corresponding app.

This makes viewing notifications a much more efficient
process, since there's a minimal need for mouse clicks, and
It's easy to see which notification belongs to which app. If
you're on the lookout for an important news flash report, for
example, you can quickly get the information you need when
It appears on your screen.
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Hover over a notification for an expansion chevron in the
upper-right corner. Click it and the notification expands to display
more information. In addition, by moving the mouse pointer over
the notification bubble you'll also see an X in the opposite top
corner, for dismissing the notification.



Notifications

Creating and Removing Notifications
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MNotification Centre shows your alerts in the upper right of your screen, without interrupting what
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Adding and removing app notifications is as simple as
navigating to System Preferences > Notifications &
Focus. It's the ‘Bell’ icon on the right-hand side of the System
Preferences window as it opens.

From there, click the Notifications tab and you're
presented with all the available apps installed on your Mac
that can provide a notification of some sort. Scroll through
the list of apps on the left pane of the Notifications window When you've found the app you want to create a
until you find the app you want to setup Notifications for, and Notification for, click on the Allow Notification from...
click on the name of the app. slider button to activate it.
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Motification Centre shows your alerts in the upper right of your screen, without interrupting what
you're doing. Show and hide Motification Centre by clicking the clock in the menu bar.
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3 Within the Notifications window, you can set a number of

options for how you want to review any Notifications from ._ o _
the app you've activated. For example, the Alert Style can be . v 1 @ ACle § " vV D& W
adjusted to None, Banners (the default, and the one that most
folk will use), and Alerts. You can also opt to display As you continue to use your Mac, so the number of
Notifications on the lock screen — although this is considered a Notifications you generate will increase, over the course of
security risk if you leave your Mac unattended. There's also a week or even a day. You'll quickly come to appreciate the
options to play a sound when a Notification comes in and you Notifications layout and design and how it greatly improves the
can set the Notification Grouping to Automatic, By App or Off. process of discovering alerts and notifications.
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Working with
Monterey's Widgets

Widgets are a useful way of getting quick and easy access to an app’s
functionality, without having to open the app itself. You can, for example, see
today’s calendar events or weather, or check the latest news stories from the
Apple News app. You can edit your widgets to suit your needs too.

First Steps with Widgets
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To access your widgets, click on the clock and date in Click on a widget to open the app that created it, or in
the top-right corner of the screen. The widgets are found some cases, the website from where its information is
underneath the notifications. You can scroll the notifications drawn. Here we clicked the AMP share price in the Stocks

and widgets up and down with two fingers on a trackpad. widget, which opened the Stocks app on the AMP details page.
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3 You can drag widgets out of their current position and Right-click on a widget for a contextual menu that lets

drop them into a new place, just like you do with app you resize the widget, remove it or access the option for
icons in Launchpad. Reorder them to suit; maybe move the editing widgets. You can do all this through the Edit screen, of
most used widgets to the top of the column. course, but this is a quick and easy alternative.




Editing Widgets

146.83

There are two ways to access the Edit Widgets option.
You can either scroll the widgets column all the way up
and click the Edit Widgets button at the bottom, or right-click a
widget and choose Edit Widgets from the menu.
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3 Click an app on the left-hand side of the screen to see
the widgets associated with that app in the centre

column. To install a widget, drag it from this centre column into
your widgets on the right-hand side of the screen.
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Some third-party apps have widgets. Sometimes an
unused third-party widget is blank until you open its
associated app. If you're interested in that widget, just open
the app and return to the Edit Widgets feature.
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When in Edit Widgets mode, the widgets in your sidebar
have a minus sign in the top-left corner. If you want to
delete a widget, click on this minus sign and it disappears. You
can add it again later if you want it back.
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Some widgets are available in Small, Medium and Large
versions. Click on the circles labelled S, M and L
underneath a widget to see what each size looks like, and
when you've chosen a size, drag it into your column.
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Third-party widgets won't update unless the app to which
they refer are open, but if this is a problem for you, simply
set up that app to open whenever you log in, and leave it open
in the background. The widget then stays up to date.




1 First Steps with macOS Monterey ]

The Spotlight Feature
Search Your Mac

Spotlight Search is Apple’s unique and ultra-powerful search system that
can find almost anything on your Mac. There's a whole raft of great features,
making it a really powerful and useful tool that's integrated into the apps that
you use every day. Here's how to get the most from the Spotlight feature.

Using Spotlight’s Features

e Edit View Ga  Window  Help @ © $ Q 8 L E © Fi245p 327pm

To start using Spotlight, press cmd and the space bar or
click the magnifying glass in the top menu and the
Spotlight Search window appears. In Big Sur, as with macOS
Catalina, you can drag this window to wherever you want on
the screen; it's not fixed in position.
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3 Spotlight can do instant unit conversions for you. For

example, if you want to convert from imperial to metric
weights (or vice versa) you just type in the number and a type
of unit, such as kilograms or pounds and Spotlight instantly
converts into other commonly used units.
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Start typing your search query into Spotlight and
Immediately answers appear, with suggestions based on

the contents of your computer as well as other sources. This
may mean you only have to type a few letters of your search
term to find what you're looking for.
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It works in a similar way with distances and lengths,
which Spotlight can instantly convert into other units. For
example, if you type a distance in miles it instantly shows what
it is In kilometres, metres, yards, feet and inches. You can even
convert parsecs into light years.




Q 100 dollars = 73.09 British pounds

[) 100 dollars = 73.09 British pounds —yahool{ nan

‘@ 100 dollars in pounds
@ 100 dollars in gbp

'@ 100 dollars to philippine peso
'@ 100 dollars to pesos
@ 100 dollars

Documants
_meqﬂ novel = full manuscrpt — 335 KB - Microsaft Word Document - Last Opened 29/04/2021.

ﬂfﬁﬁhﬁmmm newsletter — 30/07/2021 « The History Press « ian.osborne@dsl. pipex.com

Spotlight can do some currency conversions. Type in a
number and currency unit, such as dollars or pounds,
and Spotlight gives you the equivalent value in a range of
currencies at the current market value.
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7 If you're looking for local businesses or sites of interest,

simply type the name into Spotlight and you'll quickly
find what you're looking for, complete with a link to the Maps
app and the option of travel directions from your current
location plus other useful information.
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Spotlight is also closely integrated into the core macOS
apps, such as Photos. Start typing in your search term,
like the title of a particular image or photo album in your Photos
app, and Spotlight quickly locates it and takes you straight to it.
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Singapore
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Singapore, officially the Republic of
i Singapore, is a sovereign island city-

state in maritime Southeast Asia. It lies
about one degree of latitude north of the
equator, off the southern tip of the

Malay Peninsula, bordering thae Straits of Malacca to the

west, the Riau Islands to the south, and the South China

Sea to the east.
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For more conventional searches, Spotlight pulls its
information from a wide range of sources, such as

Wikipedia and documents it finds on your Mac. Search results
are listed by category down the left side of the search window.
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You can find people with Spotlight too. Start typing the
name of someone you know, and Spotlight quickly finds
that person in your Contacts list and displays their contact
details in the results window. Things like chat threads,
Facebook comments and emails are also listed.
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Created 24 September 2021
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Last Opened 24 Sep 2021 al 342 pm
Duration 2:47
Sample Rate 44,100

Spotlight can find music by searching through your iTunes
collection to find albums, tracks and artists. Type a band
name, a track name or even the name of a band member.
Recordings with that name or by that band or person are shown.
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Launching Apps
And Quitting Them

There are several ways of launching an app on your Mac. You can: use the
Launchpad, which is found in the Dock; you can open a Finder window and
navigate your way to the application you wish to use; or you can click on the
Spotlight feature and simply type its name. Here's how to do 1.

Using Launchpad

®.0fe @8 79820 2ot B0 =D s @8- T 0020 e Puu oW

To open the Launchpad, go to the Dock and click on it,
or place four fingers on your trackpad and bring them

If you have more than one page of apps, move between
them by swiping left and right with two fingers or hold

together. The screen darkens and your apps are shown as cmd and use the arrow keys. Click and hold on an app and an
icons. To launch an app from this screen, click on it. To close ‘X' appears in the top left corner; click ‘X' to delete. Not all
Launchpad, press Esc or click on the desktop. apps can be deleted in this way.

IWork Apps

1IBO"= N0 @8- 7090820 Wwu@ @ ¥

3 You can arrange your apps into folders on Launchpad Open and close folders by clicking on and off the folder

too, just like on an IOS Home screen. Just drag one app icon on the Launchpad screen. You can add new apps
onto another and a folder is created. You can click on the into the folder by simply dragging them onto the folder. You can
name if you wish to change it and to remove an app from that also drag apps around the Launchpad window to change the
folder, drag it off the grey folder area. order in which they're arranged.




Using Spotlight

@i Finder Flle Edit VYiew Go  ‘Window Help [+ 1 T

= T LA E O FridSep &15pm
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To launch an app using the Spotlight feature, first click
on the magnifying glass found in the top right corner of
the screen. A window saying ‘Spotlight Search’ pops up. If it's
inconveniently located, you can drag it around the desktop and
move it to wherever you like.

Using the Finder
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You can also launch an app using the Finder. Open a new
Finder window (or use one that’s already open) and click on
Applications in the sidebar. All of your Mac’s apps are
shown. Scroll to find the one you want to use and then
double click on the icon to launch.

Quitting Apps.

Options
Show All Windows

Open apps are shown in the Dock. On the app’s Dock icon, you
can click using the right-hand side of a Magic Mouse or trackpad
(right-click), hold the Control key and click anywhere (ctrl-click) or
click and hold, then click on Quit in the pop-up window.

Launching Apps = &

Ll

Calendar
Vorsson: 1.0

Begin to type the name of the app you want to launch
and Spotlight tries to complete it for you. When you see
the name of the app you want, scroll down to it and press
Enter and it launches. To close the Spotlight search window
without launching anything, just click anywhere on the screen.

Using the Dock

You can launch an app from the Dock. If your Dock is hidden,
move your pointer to the foot of the screen to reveal it and
click on the app you wish to use. To find out more about the
Dock and how to customise it with your favourite apps, see
our tutorial later in the book.

# Pholes Fie Edit image View Window Help P o 2 o8 T L E O mi2aSep 4:20pm

Alternatively, with the app to the fore in Finder, click on its name in
the top left corner and select Quit [app name] from the menu; or
hold the Command key and press ‘Q’. Just make sure the app is
open on your desktop or you might quit the wrong application.
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Setting Up Emall
For the Mail App

With email, you can send mails and attachments anywhere in the world, at the
push of a button. It's there instantly too. Here we take a look at what email is,
how you can get yourself an email address and how you can use your emalil
accounts on your Mac, with Apple’s bundled email client, the Mail app.

Setting Up Your iCloud Email
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If you set up your Apple ID during your Mac'’s initial
setup, or if you signed in with an existing Apple 1D, your
ICloud email account is already in place. But if not, or if you
want to add another iCloud email account to your Mail client,
follow these instructions.
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3 Now enter the Apple ID for the iCloud email account you

want to add to your Mail app, and then the password.
When you have confirmed your details you can then click on
the Sign In button to take you to the next step.
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Open the Mail application from the Dock and then under
the Mail drop-down menu found In the left of the menu
bar, click on the Add Account... link. From the pop-up menu
that appears, select the iCloud link and then click on the
Continue button to go to the next step.
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On the next screen, click on Add Account and your
ICloud account is added to the Mail app, for you to use
on your Mac. Your iCloud email can be your sole email account
or you can use it in Mail or alongside others if you wish.



Setting Up Other Emails
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Setting up my Virgin Media email on a device
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You hove two choices of settings fo use with Virgin Media email - IMAP or POR
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POP

Setting up Virgin Media email on a new device
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To configure your Mac to access your email account from
your Internet service provider, you need your emalil
address, your password to access your email account, and POP
or IMAP (incoming) and SMTP (outgoing) server addresses.
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3 When you first open Mail you're prompted to set up your

first email account. If you've previously used Mail or set
up another account, you can add further new accounts by
going to the Mail menu and selecting Add Account.
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If you're adding an account from your Internet Service
Provider, select Other Mail Provider from the screen in
Step 3. Enter details such as username, password and server
information provided by your ISP The server information should
also be on the ISP’s website.

Setting Up Email |1

B macOS Monterey includes a sophisticated email program,

simply called Mail. You can find it on the Dock, as it's there
by default. The Mail App’s icon shows the back of an envelope on
a blue background. Click on this icon to open the Mail app.
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If it's another web-based email service you're adding,
you must now enter your full name (this appears in your
own, and other people’s, contact lists), your email address and
your password. Do this, and your account is added.
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Fill in all the information for which you're asked. The exact
information required depends on the service provider in
question, but it typically includes incoming and outgoing mail
server addresses, your username, and your password. When
you've finished, click on Sign In to finish.
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Installing New Apps
On Your Mac

Installing new apps on

a Mac shouldn’t be a terrifying experience. Whether

you're downloading from the App Store or from a third-party developer’s
website, you can download and install some great new software
applications, or apps, on your Mac in macOS Monterey.

You can open the App Store app
from the Apple menu, as well as
from the Dock, the Applications
window, the Launchpad and Spotlight.
If updates are available for any of your
apps, this is shown in the Apple menu,
next to the App Store option.

Type the name of an app, a
developer or a genre into the
Search window to search the App Store
for apps. Your search results are then
shown in the main window.
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The sidebar gives you options More from Apple's editors. These
when exploring the App Store. boxes might feature individual
Discover is best for general browsing, apps, or they might offer a range of
Arcade is for Apple Arcade titles, then titles on a given theme.
there are categories for creative apps,
work-related software, games 7 Click on your name in the corner

developers’ tools and more. here to get your account details.
Scroll the page down for
individual apps and more. Click

on an app to be taken to its page. Click
Click on the chevron for more on its price (or the word ‘Get’ if it's free)
featured apps. to buy and download fit.

This is the featured app of the
day, chosen by Apple’s editors.
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The Mac App Store

The Apple Mac Store is an impressive market place of apps, that
have been registered and cleared with Apple to run on your Mac
without any hint of anything unwarranted — such as malware. But
it doesn't have everything on offer. There are times when you may
need to go outside the Mac App Store in order to get hold of a
vital app, and this is where the confusion often arises.

Installing New Apps | g&3

Beyond the Mac App Store you'll find all manner of different
kinds of apps and these are often packaged differently
depending on the developer. You can find DMG files with apps
inside them, PKG installers and even Zip archives with
applications inside. Let's keep things simple to begin with and
start with the Mac App Store.

Installing from the Mac App Store

The Mac App Store is a safe and friendly place for the Mac
user to visit and install apps from. Open the App Store via the
Dock and you'll notice that there are categories on the
left-pane, while the content relating to each category is in the
right-hand or main pane. There's also a handy Search bar at
the top of the App Store window.

Work

Farmat academic papers with ease

Copy the uncopyable

Stay on Task

Micrasoft To Do

a Todoist: To-Da List & Tasks
' €5 GET

Any.de To-do list & Calendar

To install an app from the Mac App Store, either locate it
via the Search bar — providing you know what you're
looking for — or select it from one of the categories.

Edit Store  Window  Help @ ®© 2 g+ = L EO

® @ .

1 Search

¥r Discover
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& Develop
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BR Categories
@ Updates

Trella gives you perspective over all your projects, at work and at home. Trello, Inc
Bring Trello to Mac in a dedicated workspace. The Trello Desktop App features

native notifications, powerful anhancements and more - away from the distractions
of your browsar. mare

E lan Osborme

3 The downloading and installation process may take

some time, depending on the size of the app your
installing and your connection to the Internet. Progress is
measured with a circle where the Install button was, which
Is gradually filled as the app is installed. If you need to
cancel the installation at any point, then click the square
inside the gradually filling circle.
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1 Search
Trello

Organize anything, together

7 Discover
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5> Create
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&/ Play
2 Develop

B8 Categories

] Updates

Trello gives you perspective over all your projects, at work and at home.
Bring Trello to Mac in a dedicated workspace. The Trello Desktop App features
native notifications, powerful enhancements and more - away from the distraction;

When you've found the app you want to install, click on
the Get button (for free apps) or the price button (for
paid-for apps). This button changes to a green Install button,
and when you click on Install and sign in with your Apple 1D,
your new app downloads and installs on to your Mac.

| v

SideNotes

Bartender

devolo Cockpit Trello

'O n=sEW

Once the app has finished downloading and installing,
you can either click the Open button — which has
replaced the filled circle in the Mac App Store — or you can

find the newly installed app through the Launchpad via the
Dock. Updates are handled by the App Store and anything you
purchase on one Mac will work on another compatible Mac. It's
a quick, simple and convenient way to work.




"1 First Steps with macOS Monterey ]

o) Thlrd-party Apps
“"" On Your Mac

Installing from developers’ websites does carry some baggage. For one,
you're not going to get updates from the Mac App Store, which may lead
to an unresponsive app as the core macOS system is updated. Secondly,
there’'s a potential security risk, as you've no way of knowing if the app
you're installing has any form of malware hidden deep within it. And thirdly,
It's not often quite as simple as a single click.

w  Rox Products - Digial Downlosds

Get your Roxio software here!

Download your digital copy now.

NEW

1-"ll-'-

'l”-_.;-L“‘"'L '.J

OVD authoring, disc burning, audio & video

0 eniEr your serial number or attach a hardwane device to begin softaare installation. Please ensure you have it

capture, and screen recording software for Mac
Roxio Toast Roxio Creator

LEARN MORE

Begin by locating the app you want to install — as
previously mentioned, look for a reputable site. Ensure

There's usually a Downloads section to any site where
there's apps available from the developer. In there you

that it actually has a macOS version available, as Windows can find the macOS specific installation file you need for the
or Linux developed apps won't work on a Mac (unless you app in question. Click the link to it or button, to begin the
do some clever work in the background). download of the app’s installer.

Go Window Help @ © 2 Q 8 T @ L £ © Thu23Se

el i Downloads

¥ Dropbox (Personal)

% Dropbox (Team BOM) ‘
$ Setapp |

# AirDrop
Recanis
© Alysza Falconoec! IMG_B76BEBEB72480-1. Thumbs_With_Beard. P Toa I{I | taller.drmg
A Applications “'3 .
= Desktop
™ Documen is

@ Downloads

3 Most macOS downloaded app installers come as DMG
files. A DMG file is an Apple Disk Image file or a Mac OS
X Disk Image file. It's basically a digital reconstruction of a
physical disk and stores compressed software installers
instead of having a physical medium. These DMG files can

This does one of several operations: first, macOS will
scan the DMG file and ensure it's all there and in the right

therefore be mounted as virtual disk images. order to read from. Secondly, it will open a virtual disk image
All downloads from Safari are stored in the Downloads both on the desktop and within Finder as a new external drive.
folder in Finder. Locate the folder and the DMG file you've Thirdly, you'll get a brief notice indicating how to install the

downloaded, then double-click to mount the virtual disk image.  chosen app on to your system.
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& [ Retro Virtual Machine v2

=

Retro Virtual Machine 2 Retro Virtual Machine 7 YNes

If there's an Applications folder in the window with a
small arrow in its bottom-left corner, drag the application
into this folder to install it. If the folder contains a file with a
name that ends ‘installer’, double click on that file to start the
installation process. Follow the on-screen instructions to
complete the installation. You'll then find the intsalled software
in your Applications folder where you can choose to add to
your Dock if you want to access it quickly.

roxio

toast 20

74 If you bought the app from the developer's web store,

you might have received a registration code by email.
This might be required during the installation process, or you
might be able to use the application for free for a set period
of time before a code is needed. If you're asked to input a
code during the installation, copy and paste it from the email
into the fields provided. Having done so, continue to follow
the on-screen instructions.

What are PKG Files?

One other popular file type for macOS installations is the
PKG file. Although it's not as popular as DMG files. Simply
put, a PKG file are installation packages that generally
contain automated scripts that will direct the installation of the
app in question. They will take you through a kind of setup
wizard and create a multi-step installation process.

They are usually only used where multiple additional
components are required by the app but also when different

[P

| Third-party Apps |

You are opening the application
“Toast 20 Installer” for the first
time. Are you sure you want to
open this application?

E “Toast 20 Installer” is an app downloaded from the
——

internet. Are you sure you want to open it?

100 WWOW, roaclo. com

The application is in a folder named
*Toast 20 Installer®. To sea tha

application in the Finder without apening

- o E——
j}ﬂpph:anun P

| Toast 20 Installer » @ Toast 20 Installe

Don't warn me when opening applications on this disk image

Because the application was downloaded from a
third-party site, you might get warnings such as the
ones shown here. If you’re sure you downloaded the app
from a reputable site, click on Open to proceed. You might
also have to open System Preferences > Security & Privacy >
General, click the lock (bottom left) and enter your admin
password and make sure the lower option is set to App Store
and identified developers'.

4 Rip DD o Digial & Cranls Encrypled Disc i Capbure Scresn

Rscoring

The app should launch as expected. If you come across
any problems, it's often down to the fact that you are
running a more recent version of macQOS than the app was
designed for, or the app is 32-bit, whereas macOS Monterey
will only execute 64-bit apps. If this happens, it's worth
checking with the site you downloaded it from; perhaps there’s
a more recent version to download. Otherwise, you coulc
Google the error and see what other users have to say about
the matter. Most apps often produce unique errors depending
on the developer and the app, so don't always expect the
same solution to work all of the time.

services are required from macOS or the installation files will
be placed in different areas of the Mac's file system.

One more note: Once you've installed any DMG or PKG
file, you can delete it from the system. Its job is finished now,
and the app is installed. Unless you'd like to keep it in case
you install it on another Mac, there's no need to keep hold of
it in the Downloads folder. Simply drag it into the bin and then
empty the bin to delete it from your system.
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macOS
Monterey’s

Key Apps

One of the best things about the Mac is
that it comes with a wealth of preinstalled
applications, or ‘apps’. There's the Safari
web browser, the Mail email client,
productivity apps such as Calendar, Notes
and Reminders, entertainment apps like
Apple TV, Music and books, and more.
Here we tell you all about them.

L earn more >



1 macOS Monterey’s Key Apps ]

Your Web Browser

Safari is your Mac’s built-in web browser. With it, you can explore the
worldwide web, enjoy your social media accounts, buy and sell on eBay and

more. With macOS Monterey, Safari gets an
overhaul with a great new Group Tabs option.

This icon opens and closes the
sidebar on the left.

Here you see how many tabs
you currently have open in
Safari. Click the four-squares icon to
see those tabs as thumbnails in the
main window.

3 This icon gives you a menu that
lets you make a Tab Group of
the tabs you currently have open, or
start a new, empty Tab Group to
which you can add tabs manually.

These two chevrons are your
navigation controls, which let
you move forward and backward
through your browsing history.

Click the house icon to take you
back to your designated
Homepage. Change this Homepage in
Preferences > General.

A lot of websites use trackers
to track your browsing from site
to site, in order to target advertising.
The Shield icon lets you see what
trackers have attempted to track you,
and lets you Turn On Private Relay
(iCloud+ required).

7 This is the URL Bar. Enter the
website address of your choice

or a search term that you wish to look

up into this bar, then tap the Return key:

If a web page fails to load
properly or you wish to check if it
has updated, you can refresh it by
clicking on this button and reloading.

1 2 |3 4

Click on the Sharing icon to see
your options for sharing the
page you're viewing; adding it to
Notes, making a Quick Note and
options for Add Bookmark and Add to
Reading List.

[1 5 Tabs

Tab Groups

Learning German m

Social Media

m Click the + icon to open a new,
blank tab. You can then go to a
new website without closing the one
you're currently viewing.

Cute Cats

Video Games

This takes you to the Tab
Overview, showing all your
open tabs as thumbnails in the main
window. Click on one to open it.

Apple iPhone

Received Links

‘28 Shared with You

16,

Collected Links

[l Bookmarks

Your Tab Groups. Click a group
to close the tabs you currently
have open, and open the group of
tabs you selected. To return to the
tabs you had open before, click the ‘X
Tabs’ option above it (Item 2).

OO Reading List

13 These are sites that you've

pinned to your tab bar, where
they remain. Click on one to open
that tabbed site.

These are your currently open
tabs. Click on one to open it,
hover over the tab and click the ‘X’
on the left-hand side of the tab to
close it, and click the *+'" icon (ltem
10) to open a new one.

If someone shares a link with
you in the Messages app, it

appears here.




Click these links for a list of your
Bookmarks or sites you added to

Full Screen.

Camminmiss Toolbar

your Reading List. After doing so, click ¢ o R
the chevron in the top-left of the sidebar Browse in full-screen . s e
to return to the sidebar shown here. mode by clicking on the Be
green gumdrop in the top m -
17 This is where the web page left corner, selecting Enter o
you're viewing is displayed. You Full Screen in the View el
can then scroll up and down by using menu or pressing fn-F. To T

the scroll function on your mouse or
trackpad, and navigate to new pages
by clicking on links, which can be
menus, buttons, text or images.
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Learn more >
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ﬂ macOS Monterey’'s Key Apps ]

Set New Home Page

@ Safari File Edit

Services ? | Buy Guidebooks ~

View History Bookmarks Window Help

at ©

® bdmpublications.com

Dog Media - Tech Guide... § Electronics, Cars, Fashion, Co...

wrtal MYy Account 1eip

BDM Learning Bung
Hide Safari

Hide Others

Show A

orldwide & Easy & Secure Online Check

World leading tech
guide publishers

Holnino tn malko tarh

Quit Safari

LEARI

For
GUI

for Seniars

Open a new Safari window and navigate to the web page
that you want Safari to load each time you launch the
app. Click the Safari menu (top left corner), then select
Preferences to display Safar’s preferences dialog box.

Ganeral

< e 3 Q8 06 & & %

Safari opens with: A new window

Mew windows open with:  Start Page

Mew tabs open with: Start Page

Homepage: | https:/fbdmpublications.com/

Set to Current Page

Remove history items:  After one year

Favourites shows: 1r Favourites

File download location: [ Downloads

0 @c

Remove download list items:  After one day

Dpen “safe” files after downloading
- * films include movies. piciures, sounds,
PDF and text documents, and archives ?

Ensure the General tab is selected and press the Set to
Current Page button. The required page address now
appears in the text box above. It's now your default home
page. The Home menu in the toolbar will take you there.

Using Links.

Showing 1=24 of 73 results

Sort by latest
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You navigate the Internet in Safari using hyperlinks, or simply
links’. A link can be a piece of underlined text, a picture, a button
or simply an area of the screen. To open a link you'll need to
move the mouse pointer over it and click. When the pointer is
over a link, it's replaced by a hand.

Accessing Websites

@ Safari File Edit

WView History HBookmarks Window Help ® O

o Always Show Toolbar in Full Screen
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To access a new website in the Safari browser, first
double-click in the URL bar, highlighting the text within it,
then type a new URL in this bar A URL is the website's address,
which starts ‘www'. Press return at the end to go there.
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If you want to search for something on the web, instead
of typing a URL in the URL bar, type what it is you're
searching for, then hit Return. Your search results show relevant
sites. Scroll up and down the list and click one to go to it.
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Clicking a link takes you to a new page or opens a new window
based on what you've just clicked. If you don't want to navigate
away from the page that you're currently on, right-click or Ctri-click
on the link and from the pop-up menu, choose Open in New Tab
or Open in New Window.




Add Tools to the Toolbar

® Safari

File Edit Wiew History Bookmarks Window Help

' Always Show Toolbar in Full Screen

Customise Toolbar...

8 bdmpublications.com

Always Show Tab Bar
Show Favourites Bar ¢ HB J Electronics, Cars, Fashion, Co...
Show Status Bar =/
Show Sidebar oxL §
Show Bookmarks Sidebar ~H

E Bl  show Reading List Sidebar +2 jebooks ~ BDM Learning Buni
Show Reader

Show Tab Overview

&

& Easy & Secure Online Checl

Stop
Reload Page

Translation

Actual Size
Zoom In

Zoom Out thlichare

Right-click or Ctrl-click on the toolbar and select
Customise Toolbar; or click the View menu and select the
option from there. A window slides down. To add a button to the
toolbar, simply drag it from the selection in the window onto the
Toolbar within the Flexible Space sections.

@ bilmpoibd e olemen 50
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Repeat this with as many tools as you need. When
you're finished, click Done. To remove a tool from the
toolbar, simply drag it out of the toolbar, release and it
vanishes. To reset the tools to how they were originally
displayed, drag the default set of tools onto the Toolbar.

Status, Favourite & Tab Bars

v Always Show Toolbar in Full Screen
Customise Toolbar...

: Show Favourites Bar o HB

Show Status Bar #® |
Gt Bl:

@ bdmpublications.co
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Show Sidebar
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Stop .
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Translation .
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Actual Size
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You can show or hide the Tab, Favourites and/or Status Bar (a
strip along the bottom of the window showing the full URL) by
clicking the View option in the menu bar atop the screen, and
selecting the option in question.

[ Safari

Pinned Sites.

< G ©
T

& bdmpublications.i

Duplicate Tab

About Contact Offers Code Porta
Close Tab

Close Other Tabs

Close Tabs to the Right
Move Tab to New Window
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Arrange Tabs By y & Secure Online

World Ieadmg tech §
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If your tab bar isn’'t showing, go to the View menu and select
the Always Show Tab Bar option near the top. Now open the
site you intend to pin and right or ctrl-click on its tab. From
the pop-up menu, select the Pin Tab option.

Edit View Hislory Bookmarks Window  Help

11" r.' B bdmpubdications.com
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The site gets a small tab in the left-hand side of the tabs
bar. This is always in place, ready for you to click on it and
open the site. You can pin multiple sites in this way. They all
appear as small tabs, showing a symbol or letter.

G © | @ bdmp
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: Duplicate Tab
About Contact Offers ( P Account Help

Close Tab

Ya{ Black Dog Media

Buy Guidebooks + BDN
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L

To remove a site’'s pinned tab, right-click or Ctrl-click on it and
from the pop-up menu, select Unpin Tab. The previously
pinned tab then becomes a regular tab. You can reorder your
pinned tabs by dragging them within the tabs bar.
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Bookmarks and Reading List

® Safari File

Edit View History Bookmarks Window Help
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= apple.com
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iPhone 13 Pro

i

You can save a website you're likely to return to often as
a Bookmark. A site you're interested in but don't have
time to read can be put on your Reading List. Both options are
available from the Share icon in the toolbar.

Safari Flle Edit View History Bookmarks Window Help ® O % )

a ©
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iPhone 13 Pro

Oh. So. Pro.

3 To access your Bookmarks and Reading List, open the
sidebar and click on the option, found under Collected
Links. Click a site to open it. In the Bookmarks sidebar, as shown,

you can right/Ctrl click and add a new folder if you wish.

The Start Page.
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Frequently Visited

Start Page gives you a window full of useful shortcuts to your
most frequently visited sites alongside its default choices. Click
on the URL field at the top of the browser or in the Bookmarks
menu. Select, Show Start Page to access a window showing a
grid view of website icons, along with those you've visited most
recently and the default links to other sites.

I = iPhone 13 Pro and IPhone 13 P... I} Elactronics, Cars, Fashion, Col.. W Wikipedia A Rescue, ne]
e 13 Prﬂ fuiEW Tech Specs '
Add this page to:
B3 Useful Apple Sites

Ehm're 13 Pro and iPhone 13 Pro Max - Apple (UK)

cancel  (SETED

When adding a bookmark, a pop-up window appears.
You can add a custom title for the website you're saving,
plus there's an optional description field and a pull-down menu
that lets you add your site one of your bookmark folders.
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In the Reading List, drag a site left to save it for offline
reading or to delete it. The right/Ctrl click menu has an
option to remove/delete a site from either list. Click the small
chevron, top left, to return to the regular sidebar.
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To add a site, click the URL field to open the Start Page and
drag the URL into it. You can drag sites and folders into this
window from your Bookmarks too. Drag icons around the Start
Page to reorder them, or drag out of it to remove them. Scroll
up for Siri suggestions, Frequently Visited and more. Click a
Show More/Less link to expand/contract a category.




Tab Groups

®@e0ce [

& bdmpubl

[l 5Tabs ‘ New Empty Tab Group

New Tab Group with 5 Tabs

YUa( Black Dog Media

Black Dog Me Wikipedia

Tab Groups

Social Media
Cute Cats

Video Games
Apple iPhone

& Millions of Readers Worldwide s Easy & Secure

Recemwved Links

M Shared with You

Collected Links

[l Bookmarks

World lea

OO Reading List

Safari now lets you save groups of tabs. You can then
open a group of tabs, temporarily closing what's open at
the moment. Open the sidebar, then tap the New Tab Group
icon in the top-right of the sidebar for a menu.

w 0 &

m citylit.ac.uk o4

Ingo - Tha world's bas... :,. LXG001_1 - OpanLearn - O... Br Google Translate ® Learn German Online & In L.

Q

here: ¢ Home < Languages <« European < German

burses Learn German — Courses Online & In London

ility “~  German is one the most wide spoken languages in the world with nearly 80 million native
speakers across Germany, Austria, Belgium, Luxembourg and Switzerland. German and

flable courses (19)  English come from the same family of Germanic languages and some of the oldest

e o 4 ' English words can be traced back to German origins but some modern day German

3 With your new tab group open (see the highlight in the

sidebar), tap the + icon (top right) to open a new tab,
then navigate to the site you wish to save in the tab group. Do
this as many times as you like to fill your tab group.

The Tabs Audio Indicator
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KW Francais
+ CTaTed 2 340 000+ articles

b

If one of your Safari tabs is playing audio and you're not
sure which one, look for the tab with the speaker icon,
shown on its right. You can mute this sound by clicking on this
speaker icon. Click again to unmute.
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From the menu, you can make a group from all the tabs
you currently have open, or start a new, empty group
and then add tabs to it. We'll do the latter here. Either way, you
get to name the new tab group. Press Return when done.

i Dusclingo - The world's bes...

o LYGO01_1 - OpenLearn - O... & coogle Translate

w e LXGDO11 - Open.. « [ Learn German On..

¥ [ Duclingo - The w..

w B Google Transiate
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Use the sidebar to switch between saved groups of tabs
and the tabs you have open on your Mac. Tap a tab
group and then tap the icon to its right to see the tabs as
thumbnails. Tab Groups are synced across your Apple gear.

» wikipedia.org 4 C

I_ ; ) = - 1
Mute This Tab .

Mute Other Tabs
Enter Picture in Picture
Auto-Play >

WIKIPE
The Free Encycl EThe

Diamond on Vimeo
@ Spider-Man: Into the Spidervers...f Faith" - Art of the Scene - IGN

3 A Guided Tour of iPhone 13 & iPhone 13 Pro | Apple - YouTube
5 TZ75 UUU+ 565

Deutsch
2 590 000+ Artikel

Erancaic ¥,

If more than one tab is producing audio, right-click on
one of them for options to mute that tab, mute the others
that are making a sound or enter Picture in Picture mode to
watch the video in a floating screen.
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Safari’s Shield

® Safari File

Edit View History Bookmarks Window Help

e M~ <
f B

& betawhsmith.co.uk

a ©

w 11 trackers prevented from
profiling you

@ : | WHSmith

SPEND £50! USE PROMC

WH Smith

EST 1751

anll ™ Trackers on This Web Page

bing.com

contentsquare.net

doubleclick.net
dwinl.com
facebook.com
facebook.net

_: *
< -'-:'-:
Click the Shield icon which is found to the left of the URL
field for a report on what trackers Safari has prevented

from following you. Click the chevron to list them, and the ‘i’ icon
for more information about site tracking and why websites do it.

Tailor Site Settings

( Safari File Edit \View History Bookmarks Window  Help ®@ © 3
About Safari -
Safari Extensions...
Preferences af © # bbc.co.uk
Privacy Repaort... =
Settings for bbec.co.uk When visiting bbc.co.uk:
Clear History  Use Reader when available
) L
: 5.:' icas > Enable content blockers
Hide Safari ®H Page Zoom: 100%
Hide Oth | Auto-Play: Allow All Auto-Play .
| Pop-up Windows: Block and Notify
Showe A \ -
) usic 7 F
Quit Safari - Camera: Ask

Microphone: Ask
Screen Sharing: Ask
Location: Ask

Listen Live

There's a number of useful tools for tailoring your
experience on a per-site basis. Open the website and in
the Safari menu, select Settings for [the website]. You can
enable or disable content blockers, go straight to Reader View,
change the page zoom, stop auto-playing videos and more.

The Reader View.

Safari File Edit WView Histery Bookmarks Window  Help

@ ©® 2 Q = T m L

B enwikipedia.org

& Mot logged in Tak Contributions Creabe acco

&2 W Atew. L Fead Wiewsource View history | Search Wikipedia
L
WiKIPEDIA Apple Inc.
btz From Wikipedia, Coondnains: gy 37.3340°NH 1
Radiractad from
Main page
Conberits “Appie fcomg ies, see Apple (disambiguation) § Organisalions and companies:

Cumant pwanrs
Aandom articls
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services, Apple is the worid's
T4.5 billion in 2020) and, Since ’

Apple Inc.

i s
R arges! technology
E January 2021, the workd™ _#hy. As of 2021, Apple is the world's
fowrth-largesi PC vendar by unil s and lourth-largest smarphona
Contribute manufacturer."™ 1t is one of the Big Five American information technalogy companies,
Hxlgy along with Amazon, Google, Microsoft, and Facabook 1213014
Leam to edit

The Reader View isn't available on every web page. Look for
this icon that appears in the left-hand side of the URL field.
When it's there, you can click it to access the Reader View, for
a simpler (and far more easily printed) page.

L o Ll =

o ‘ Photos

e o

@ Private Relay: On Turn Off...

. Private Relay keeps your internet activity private and secure. |t protects your Safari
@RS8  browsing with complete IP masking and web traffic encryption. It even protects you
whean using apps, preventing I5Ps from profiling you.

i3 P Address Location:

You can keep using your general IP address location so that websites can provide
ﬂ B local content in safari, or you can choose to use a broader IP address location in your
| country and time zone.

O Maintain General Location
£ Y Use Country and Time Zone

5 lgnﬁshnrnn's iPa... iCloud Storage: 50 GB (20.08 GB Available)

PN 0 W o0ice

hinnorm

If you have a paid-for iCloud subscription you can turn
on Private Relay, which prevents websites from viewing
your IP address. To turn it on and off, go to System Preferences
> Apple ID and under Private Relay, click the Options button.

@ Safari File Edit View History Bookmarks Window Help ®@ 9

m bbc.co.uk

G ©

W Elack Dog Media

When visiting bbe.co.uk:

.\ Use Reade gpu Eﬂ-

2 Enablecor  75%
85%

Let us know you agree
to cookies

EE o lan Osborne

Page Zoon s 100%

Auto-Pla 1158  Auto-Play *
Pop-up Window 125% | Notify
(‘ ("' usic
SOUNDS  E

Microphon  170%
Screan Sharing ~ 200%
Locatio) 250%

Listen Live S

Page Zoom and Auto-Play are set with pull-down menus
that appear when you click their current values. By default,
the Auto-Play function stops videos with sound automatically
playing but you can override this using the Auto-Play menu. These
settings are applied whenever you load that site.

@ 9 2 Q9

‘ View History Bookmarks Window Help

O~ < @ 0 (P
- Use Reader Automatically on "enwikipedia.org” -
B O W S 'Ii Reader Websites Preferences... l
& Not logged in Talk Conf
Article Talk Read View source View history | Sear
oiA  Apple Inc.
flapaa From Wikipedia, the free encyclopedia Coorey
[Redirected from Apple inc)
"Apple (company)" redirects here. For other companies, see Apple (disambiguation) § Organisations and
Apple Inc. is an American multinational technology company that specializes in ‘
4 consumer electronics, computer software, and online services. Apple is the world's J

Reader View can be configured to your own requirements.
Right or Ctrl-click on the Reader View icon and you get a menu
from where you can opt to always use Reader View on the
current site, or open the Reader View preferences.




Getting More from Safari

@ Safari File Edit View History Bookmarks Window Help ® 4

Bearch or enter website name

Private Browsing Enabled

Safan will keep your browsing history private for all tabs in this window. After you close this window, Safari won't remember the pag
AutoFill information.

Favourites
.' .' /{ m ' n
ou hittps:ff Apple Resciee, Tep Tech Latest Free Peaple's
Garman develop.., {Linited.., Rehama,.. Confare... stuff |... Pension
B T
= CIED &
- \RF = [
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Private Browsing

Private Browsing lets you browse the Internet without adding
tracking cookies or recording where you've been in your history:.
Activate Privacy Mode by selecting New Private Window in the
File menu. In a private window, the URL field is darkened.

Passwords
i = ¥ Q 8 ® 4r %
Ganar | Tabs Autol Passaards G E I Aokt E A A
Passwords Are Locked

To unlock passwords, anter the password 1or
the user “lan Osboma®

E

Stored Passwords

You can access any stored login credentials from a website by
entering Safari > Preferences, then clicking on the Passwords
section. You need to enter your admin password to unlock
them. You can see if passwords have been compromised, and
change them from this window.
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Bookmarks and History

iPhone - Apple
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Integrated Spotlight Search

Spotlight search is a tightly integrated feature of macQOS,
including Safari. From the search bar you can find links to
web pages, bookmarks and browsing history; simply by
typing a search term. Click on one of the responses to open
that particular website in your browser.

History Bookmarks Window Help

@ Safarl File Edit  View

@ bdmpublications.com

=g
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| Clear History... gt i

Services ¥ ) .
Buy Guidebooks BDM Learning Bun
Hide Safari
Hide Others
Show A
ide @ Easy & Secure Online Check
Quit Safari

Clear Browsing History

In the Safar menu, there’s an option Clear History, which erases
your browsing history and website data. Hold Alt while you select it
to delete your browsing history; but not website data. In the pop-up,
choose whether to delete all or recent history with the pull-down.

Search
& D = § Q 8 & & D B
General Tabs AutoFill PFasswords Search Security Privacy ‘Websites Extensions Advanced
Search engine: Google E

Include search engine suggestions

Smart Search Field: Include Safari Suggestions

Enable Quick Website Search  Manage Websites...

Preload Top Hit in the background
Show Favourites ?

Change Your Search Engine

To change the search engine Safari uses by default, select
Preferences from the Safari menu. Click on the Search tab
and from the pull-down select the search engine you want
to use. The sites on offer are Google, Yahoo, Bing,
DuckDuckGo and Ecosia.

Salar Catensions

TPasswond 7 - Passwnrd Manager

- Bleckar; Ad Blockar & Privacy
HioCh aFs, Trackers
GET

N o

Safari Extensions

You can add great extensions to Safari to expand its
functionality and speed up your workflow. Open Safari's
Preferences window (Safari > Preferences) and select
Extensions. Click on the More Extensions button to access the
App Store's extensions page, from where they can be installed.
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Mail
end & Recelve Emall

Monterey has a great bundled email application, so sending and receiving
emails is as easy as typing a message and clicking a button. Here's how to
get the most from the Mail app.

This is the sidebar, which lets you select
mailboxes, see emails from VIP senders
or those which you've flagged, and more. You
can resize and even close this sidebar by
clicking and dragging the divider between
this and your emails list.

The list of emails contained in the
currently selected mailbox, in this
case, All Mailboxes. The number of emails in
the box, and the number of unread emails,
are shown. You can resize this column by
clicking and dragging its left or right edge.

Click this circular icon to toggle
petween showing all emails and only
unread emails.

This button downloads new emails. You
can set your Mail app to check
automatically but this button does so manually.

When you want to write a new email
from scratch, click on this button to
open a blank one.

This button archives the selected
message. Very useful if you want to
make sure you don't delete it.

7 If you want to throw away the currently
selected email, click here to send it to
the Trash folder.

This button moves the selected email to
your junk mail folder. Use it to help the
Mail app identify ‘spam’, which is junk emails.

This button lets you reply to the
currently selected email, with the reply
going to its sender only.

File Edit Mailbox Window

@€ Mail View Message Format

2

All Inboxes
® ® n 8,706 messages, 37 unread @
Favourites
lan Osborne Inbox -... 10:07 am lan Osbo

v £ All Inboxes

;Z E 1y
w Essential A

Essential AppleUser Magazine Iss...

& iCloud Hey, look what's out? | can't wait to To: lan Os
17 read it. B m
&9 Pipex 37 m
® Microsoft Sto bo.. 9:44 am Hev. look what's oL
VIPs i =g o ey, look what's oL
Be in with a chance of winning £1...
Jjames Gale Buy an Xbox Series S today B

Jon White

® Games That... Inb... IPhone © |

[New post] Retro

9:371am

Karl Linstead
fgasking posted: "1991 Core Design
Platforms: Commodore Amiga and...

Mark Ayshford
Martin Smith o

pAI0 Flagged
> <7 All Sent

The Independ... Inb..
Grow up and tackle climate crisis,...

The Independent's Morning
Headlines email View online...

/.93 am

Cloud eBay Inbox - Pipex 3:47 am
Watch Replacement TV Remot... f...
&3 Inbox You'll know instantly with Watch List
Did the price drop? Be one of the...
(3 Drafts
< Sent m DLI.ID“I"IQIJ Inbox - Pi...  Yesterday
Hi lan Osborne! That 534 day str...
& Junk Learning a language requires
practice every day....
i Bin
_ Fanatical Bu... Inb.. Yesterday
& Archive Pick from 22 Steam games! NEW...
PLUS | Free games and coupons
Pipex when you spend ...
&3 Inbox 37 Readly Inbox-iCloud Yesterday
E] Drafts Mew issues of your favourite mag...

Yay, a new issue of MacFormat is

Checking for Mail.. 25 out! MacFormat Click here to open...




Use this button to reply
to the sender of the
currently selected email, but
also to everyone else that
received it.

If you want to forward
an email to a third party,
that is, not the person who
sent it to you, use this button.

Click the flag to mark
the currently open

email with a flag of this

colour. Click the chevron
next to the flag for a
pull-down menu that lets you
select a different flag.

Use this button to
silence notifications on
threads that are sending you
too many alerts.

This pull-down menu is
another way of moving
an email into another mailbox
or folder,

e

14

Move to...

S © Wed22Sep 10:29 am

borne nbox

ial AppleUser Magazine Issue 30 is here!
ER 21

20

s out? | can't wait to read it.

1 Osborne

 MacBooks ¢ iIPad * Mac ¢ iPod touch » « Watch - &« TV

SSENTIA L I

ISSUE 30 | OCTOBER 2021

=- ::] [ F';, oy

Information about what
mailbox the open emalil
IS In, what time it was
received and the paper clip
shows it has attachments.

To search for a specific
subject, person or word/

phrase in your emails, use the
field here.

These are emalil
iInboxes and as you

17

can see, we have two emalill

16
5]

10:07 am

accounts set up in Mail;
however, you can have more
or fewer if you prefer.

Your emails appear
here. Unread emails
are shown with a blue dot to
the left. Click on an email to
open it in the main window.

19 If the email's sender is
in your Contacts and
has a picture, it appears
here. If not, it's just a grey
circle with an initial in it. To
the right is information about
who sent and received the
open email, and its subject.

Hover over the top of

the open email and
the icons numbered 7-11 are
repeated. Their functionality
IS the same.

If the open email has
attachments, click here
for a pull-down listing them all,
from where you can select and
open them.

If you've identified
senders as VIPs, they're
listed here. Click ‘VIPs' to open
and close this section, and
click on a VIP name to see
emails from that person.

Here you can access
emails you've flagged,
or those you have sent from
your email accounts.

Various other mailboxes
associated with the
accounts you've set up in Mail.

When new emails are
downloading or
sending, it says so here.

The Column Layout.

—

MAGAZINE

Tl e v

To use the old-school,
column-based layout, in
the View menu, select
Use Column Layout.
Repeat this step to revert
to the modern layout.
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Sending a New Email
= © ®B O @ 0

jages, 34 unread

sborne Inbox -.. 10:07 am lan Osborne

ial AppleUser Magazine Iss... Essential AppleUser Mag
ok what's out? | can't wait *g To: lan Osborne

soft Store Inbo...

yith a chance of winning

Hey, look what’s out? | can’t wait

Xbox Series S today

s That... Inb...
post] Retro

9:31am

Here we show you how to open a new, blank email, write
a message and send it to a given email address using
the Mac's Mail app. To open a new email, first click on the
Compose New Message icon in the toolbar on top of the
window; the one that looks like a pen writing on paper.

To: James Galev Mark Ayshford ~
Cc: Martin Smith~ Karl Linstead ~
Subject: Things to discuss|

From: lan Osborne - atsk94@dsl.pipex.com

3 It's always a good idea to put something in the subject
line, even If it's just ‘Hello!". Type the body of your
message In the large space below. An email can be as long
as you like and you can use different fonts, colours and

sizes if you really feel the need.

Customising Mail.

(@ Mall Fie Edit View Maibcx Messoge Format  Window  Help

@ 9 £ a4 =

& @ Aa o0

Tahare e el Tesda & Coloua  Viewilg Compasisg
Default amall reader:  [T] Mail (150 B
Check for new messages: Automalically B8
Harw mossages sound: | Mow Messages Sound &3

& Play sounds for othes mail actions
Dock urresd count: b Only Ed
Mew message natificationa:  mbox Only E

Downloads folder: B Downdoads [

Remave unedited downiDads:  Alter Messags |5 Delated B

Archive ar delete muted messages
Autcmatically try sending later ¥ outgoing sarver is unavallabla
B Praler opening messages in Solt Vew when in lull screen

When searching all mallboxses, include results from
Bin
Jumnk

You can customise your Mail app by opening it and, in the Mail
pull-down menu, selecting Preferences. Under the General tab,
you can set an interval to check for new messages, decide
where downloaded attachments go and more.

®@ © 3 A 8 T m L §)

e @- I

ece <« BE- & Aa

fo: James Gale~ Mark Ayshiord -

Cr: Martin Smith~ Karl Linstead ~ ®
Supject:

From: lan Osborne - atsk94a@dsl. pipex.com Signature: None 2]

To send someone an emaill, type their email address into
the box marked To:. To also send it to someone else,
add their email address in the Cc: box. Add multiple email
addresses in either box, separated by commas, to send the
same message to a group of people.

ece <« EH- & Aa @ @~

To James Gale~ Mark Ayshford -
Lot Martin Smith~  Karl Linstead ~
Subject: Things to discuss

From: lan Osborne - atsk94@dsl.pipex.com Signature: None g

Hi folks,

A lew thungs we need o discuss regarding the nexd project,
* Furmitura for the new office building.

* Finalising the leasa.

* Talk 1o the contractor about our deadlines.

* Make sura the stalf know whal's expacted of tham,

Dwes anyana have anything to add to this?

Regards,
lan Ozborme

Once you've finished typing your letter, click the Send
button in the top left corner of the email panel to send it
on its way. Email is usually sent very quickly, and your
addressee should receive it within a couple of minutes, as long
as there are no issues with their connection or provider.

Fonts & Colours

& @ W Aa ©00 [ H R H m

General Accounts Junk Mail Fonts& Colowrs. Viewing Composing  Signatures Rules Extensions  Privacy

Message list font: System Font Regular 11 Select...

Message font: Helvetica 12 Select...

Fixed-width font: Menlo Regular 11 Salect. ..

Uze fixed-width font for plain text messages
Colour quoted text
Bl Purple

B Teal
Bl Green

Level One

($]
E Level Twao

| Lavel Three

The Fonts & Colours tab lets you change the fonts and text
size used with incoming emails and change the colours of
quoted text. Explore the Mail preferences and set up how you
choose, but be careful with the server settings.




Receiving Email.

When you receive an emalil in your inbox, this is how
you open and read it using the macOS Mail app.

s Ty
Gamas That . Games That Weren't
[Mew post] Retro [New pest] Retro
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shen you spend foasking | Septembar 22, 2029 &l 930 AMmiga. Alan 5T
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Once you've set up your email account, you can send
and receive email. As soon as you launch Mall, it
connects to your email service and collect any email that
Is waiting for you. These messages are shown as a list in
your Inbox. Click on one and it's displayed on the right.

o B W T

Xes
ssages, 34 unread @

Games That Weren't
ew post] Retro
lan Osborne

1es That... Inb...
 post] Retro

¢ing posted: "1991 Core Design
orms: Commodore Amiga and...

9:31am

Independ... Inb.. 7:53am
up and tackle climate crisis,...

Mloss: mant an D amans

While Mail is running, it periodically checks the server for
new messages. You can also prompt Mail to look at the
server immediately by clicking the button in the top left of
the screen that looks like an envelope.

Adding Attachments.

30 October 2020 at 4:56 pm

pdependent Manual

and 12 Pro manuals, price free! We brand to
B run promotions across the socials etc, free

o do is have people send us a pic of them posing
party and they get the magazine for free?

What do you think |

Cheers

Replying to & Forwarding Email

If someone you know sends you an email, you'll probably want
to reply to them. Simply click on the email so you are viewing
the text of it, then at the top of the screen you'll find a row of
three buttons, as you can see here.

The leftmost one has a single left-pointing arrow on it. This

is the Reply button. If you click on this you'll see a window
pop up that looks a lot like the window for a new email, but it will
have the responder's email address already in the To: box.

Next to the Reply button is a similar button with two left

arrows on it. This is the Reply All button; use this with
extreme care. If you have been sent an email that has also
been sent to a number of other recipients, hitting Reply All will
send your reply to everyone who received the original mail.
Obviously if your reply was meant to be private this is a very
bad idea, and has got many people into trouble.

The rightmost button of these three is the Forward button,
which is used to send an email you've received to
another recipient. Forwarding emails is another thing that
requires care; make sure that you don't accidentally send private
iInformation to someone who was not meant to receive it.

Almost any type of file can be attached and sent over the Internet along with your email.

eve ¥ B A @ @

&
o James Gale «
1]
Subject: Look at this!
From: lan Osborne — atsk94@dsl.pipex.com Signature: MNone

To add an attachment, first start an email (or reply to one
you received), and then click on the button bearing the
picture of a paperclip, at the top right of the email panel. This
will open a Finder window, allowing you to navigate to the
file or files that you want to send. Select the ones you want,
then click Choose File to attach them.

Subject: Look at this!
From: lan Osbome - atsk84@dsl pipex.com Cignature:  Mone

Message Size: 108 KB Image Size:  Medium

Opan Attachment
Open With ¥
Quick Look Attachment

Save Attachment
Save 1o Downloads Folder
Share >

View as lcon

Copy Image

Ingart from iPhone ar iPad »

In Mail, pictures you've included as attachments are shown
in the body of the email for convenient viewing. This means
you can turn your email into a mini-illustrated article if you
want; or, if you don’'t want to display it as an attachment,
right-click on it and from the contextual menu, choose View
as Icon. It can still be opened by the recipient.
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The Mail Markup Feature

dif  view Malbox  Message  Formal | wWindow | Help ZF 0] - - B L o O Wed

Jamas Gale -

Threa hikars

lan Osbarng — altskS4a Bd s pipes. com [

The Markup feature lets you add notes and scribbles to
pictures that are attached to an email before you send it. To
begin using the Mail app’s Markup feature, start writing an email
and attacn a photo to it in the usual way.

None £

Medium £

Click on the attached image, and then click on the
small chevron that appears in the upper right corner of
the photograph. Select the Markup option to open the Mall
app’s Markup feature. You can also use certain third-party
apps to edit photos further this way.

e sl Thige hikiers

¥

From: Bn Osborne - atskid4 @dsl. pipex.com Siggnature: | Mona

-

Frank

3 You can now use the interface that appears to add text,

drawings, or a range of shapes and symbols directly
onto the photo, in the email environment. When you're
finished, click the Done button and either mark up more
pictures or send your email as normal.
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Move to...

Highlight or open an email. In the top-right corner there's
a pull-down menu marked ‘Move to..." in the toolbar. If
your Mail window is small, you might have to click on a
chevron and select it from a menu. This lets you move it
to one of your folders including Trash, Junk, and folders
you've set up yourself.

(£ Move to...

[ All Drafts
<7 All Sent

W All Bins

Junk

& Archive

azine Issue 30 is here!

=] Archive
£ Inbox
4 Drafts

* iPad * Mac * iPod touch » & Watc

100% INDEPENDENT
\ A

Show Only Unread Messages.

You can hide emails you've already read by clicking this
icon. Now only unread messages are shown. Click it again
to show all your emails once more. It's great for finding
emails that you received a while ago but haven’t seen yet.

All Inboxes

® Etsy

" ;
&3 All Inboxes Reset Your Password

& iCloud

&3 Pipex
@ lain Rob Wr...
ViPs More puppa pics W
James Gale ' ' e
Jon White
® Amazon.co....

Karl Linstead Kindle Daily Deal: Boo

Mark Ayshford

Flagging an Email.

To mark an email with a flag, highlighting it for later reference,
click on the Flag pull-down and choose a colour. You can add
more than one flag to a single email. To remove them again,
choose Clear Flag. The ‘Flagged’ option in the side bar
shows emails you've marked.

Yellow

= Green

® Re. Novel View in browser

Clear Flag
Toggle Flag




Mail Drop.

If you need to send large attachments via email,
the Mail Drop feature is very useful.

QP

Would you like to send this
attachment using Mail Drop?
Thes attachment may De (oo langs 10
send in email. Mail Drop can deliver a

large attachmant using iCloud. It will be
avallabde for the next 14 days

Try Sendeng in Email

Cancel

Don't ask again for this account

If an attachment you wish to email is too large for a
reqgular email, it's stored on Apple’s server and offered
as a download instead. Depending on whether the
recipient is using Mail, the attachment could appear as a
download link or as thumbnails.

Sove All (104 GB

= Inthe City 4.jpg
- [ the Baach 03 jpg
- Coronavirus 4.jpg
- Ontha Baach 04.jopg e
-~ O the Beach 05./pg
- Rock Festival 02 jpg
«  Rock Fastival 12.jpg
-~ Rock Fastival 06.jpg
- Coronavirug 3.jpg
| - Inthe Woods 3ipg

- Family Maal 06 jpg

! - Family Maal 12./pg
- On the Beach 13.jpg

Here, we received huge photos, which are displayed as
thumbnails. You can download them all by hovering over the
email and clicking on the paperclip as shown. They're kept
on Apple’s server for a month from the date they were sent.

Mail in Full Screen Mode.

Mail (O]

Searching Your Emails

» | QL Pictures o

62 Subject contains: Pictures

>4 Pictures again

54 More sweep pictures

549 Capture and create perfect pictures!

& Attachment name contains: Pictures

Click the magnifying glass icon and type your search
term into the search field. Suggestions are offered for
items such as people, subjects and attachments; emails that
meet your search requirements are shown in the email list.

@ © 2 Q 2 7 wa Q & © Wed22Sep 12:25pm
-
» | Q BRSNS Pictures o
v Subject

Entire Message

After clicking on one of the suggested items, you can
adjust your search by clicking the first word in the field
and choosing a new option, as shown here, or even adding a
second search term for more advanced searches.

The Mail app’s full-screen mode works in a different way to other apps. Here's a guide on how to use this useful feature.
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Writing or replying to an email when the Mail app is in full
screen mode involves working in a split screen view. Click on
the green gumdrop in the top left corner of the Mail app
window to take the app into full screen mode.
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Start a new email or reply to one. The screen is split, with your
outgoing email shown on the right. Drag the dividing line left or
right to resize the windows. The email's gumdrops are shown
by dragging your pointer to the top of the screen.
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Using Mail Signatures.

You can add a signature to your emails, that is, a short
piece of text that's at the foot of every email you send.

Always match my cefault message font
el i+ Rl

Choose Signature:  Mome [2]
B Pisce smrstune above guoted test

A signature is a piece of text that you can add to the foot of
your email automatically. To set one or more up, open Mail
Preferences (from the Mail menu), click on Signatures in the
top bar and then on the account to which you wish to add a
signature in the accounts on the left. Click on the '+ button
under the middle column to add a signature.

ese <« BEH- & A @ @~

To:  James Gale -

|:".-\..
afa s

Subject: Update for project MNone
From: lan Osborne - atsk94@dsl.pipex.com ALY v Work Signature |

Jim, Edit Signatures

The schedule is on targel. The project should be finished tomarmow.
Regards,

lan Osborme
Group Editor, Apple Bookazines
Papercut Limited / Black Dog Madia

Tel: 07843 129740
Email; ian@bdmpublications.com
wiww bdmpubications.com

You can click on the name of it in the middle column and
change it to anything you like, and write your chosen
signature in the right-hand column. It can be anything you
want. Now, when writing, forwarding, or replying to an
email, you can add or remove your signature using the
pull-down menu to the right of the From field.

Accessing Emoijis.

pe @ G-

ece <« [E-
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Ui oouy
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W e U
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The Mail app has an emoji picker to use when writing an
email. Click on the smiley face in the toolbar and you get a
choice of emoji to add to your email. To add it, just click on
the one you want. Scroll up and down, or click the icons at
the bottom for more choices.

More Mail Features

S = _ PE=S==—m— =
52 [ B uw - &S &L 2 B . R B Movet
@ Mr. James Morgan - [t e S B3 Inbox - Pipex 17 Septer

| WANT YOU TO BE THE

To: lan Osborne, Copy Address

Reply-To: jamesmorgal  a4d to VIPS

Block Contact

Aftn: SirfMadam New Email
A customer of ours who died niné 5 44 t5 Contacts 1 leaving behind an estate/capital (\
here where | work,
till date nobody has come forwan

Search for "Mr. James Morgan”
During the Bank private search for ine 1are genue man reianves your name and email contact was among the fil
the same surname as the deceased who died intestate with no Will or next of kin. To maintain the level of secur
intentionally left out the final details.

Banking regulation/legislation demand that | notify the fiscal authorities after a statutory time period when dormi
type are called in by the monetary regulatory bodies if nobody applies to claim the funds.| urge you to come fon

provide you with the details needed for you to claim the estate/capital so that | can be gratify by you,in this way
# . T Sank ave the clai S '

Block Contact

To block a sender who sends you emails you don't wish to
receive, click on that person's name in the incoming email and
select Block Contact. To stop blocked emails reaching your
inbox, in Mail Preferences, go to Junk Mail and click the Blocked
tab. Select ‘Move it to the Bin' to send emails from blocked
senders straight to the bin.

Move to... Q

Mute selected conversations
B2 Inbox - Pipex 17 September 2021 at 3:54 pm
IVE THANKS.123.188

l.com

unami tragedy in Indonesia leaving behind an estate/capital (US$20M) in a Bank

\,

Mute Thread

If an email exchange is throwing up too many notifications, you
can mute it by clicking on the crossed-out bell in the toolbar. The
emails still arrive as usual, but, until you unmute it again, you
won't get notifications on delivery.

-

—

&4 = = R A A > Mmoo A B Move to...

Microsoft Store B3 inbox - Plpes
Be in with a chance of winning £125 to spend at Microsoft Store
To: lan Osborne

Unsubscribe

If an incoming email is from a mailing list, the Unsubscribe link
now appears right at the top of the email. Click the Unsubscribe
link to stop this mailing list from sending you emails in the future.




Mail and Home App

Home
For the Smart Home

Apple’'s HomeKit gave developers the means to control compatible household
gadgets from devices such as the Mac, iIPhone, IPad and iPod touch. Your

connected home gear can be controlled under one application. You can set up
automations too, so multiple devices can be activated with a single instruction.

= Edit Format  View Window  Help ®@ © 2 =2 F 8 J E O W

Include in Favourites

Before you can make use of the Home app, you have to When you've added one or more devices using your
add HomeKit compatible devices. You can only do this IOS device, you can access them through Home on the
from an iOS device, you can't use your Mac. There's a list of Mac. Right-click on a device’s window and select Settings and
HomeKit compatible devices online at www.apple.co/ZMFjhb3. you can change the room they're assigned to.

Autamation

Hass volur accassores rmact to chanoes at hama
Mew Scena

ﬂ'*_ Arrive Home

3 Click the Automation tab and you can set timers, actions For example, you can use the Home app to control

and more. What they do depends on what kit you've and configure speakers that are compatible with
iIncorporated into your Home app. Click the + icon to add HomeKit. Naturally, Apple's own HomePod, pictured here,
automations or groups of automations (scenes). fits the bill but there are plenty more.
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Music
Play Your Tunes

The Music app Is great for enjoying all your sounds on the Mac. If you
subscribe to the Apple Music service, you can stream from over 70 million
tfracks and numerous online radio stations. You can rip your CDs and store
them on your Mac, and you can also compile your own playlists.

The Music app is very similar
to the one found on the iPhone
or the iPad. If you already use
Music on a mobile device,

you shouldn’t have too many
problems getting started.

When you're using the Music
app, the top bar gives you
pull-down menus offering controls and
options. It's worthwhile familiarising
yourself with them.

Completion suggestions are
offered as you type, and results
can be limited to Apple Music, or your
on-Mac library, as you wish. Results
include artists, songs, albums and more.

These are, in turn, Shuffle Tracks,
Previous track, Play/Pause, Next
track, Repeat Play:.

When you're playing music, the
album art, artist and title are
shown here. Click on the album art to
switch to the mini player, which shows
the album art and controls only and
takes up much less space on the
screen. The line under the track name
lets you scrub through the song.

Click and drag the dot, and move it
left and right to change the volume.

These three icons, in turn are;
wirelessly transmit your music to
Bluetooth headphones or speakers;
open a sidebar showing the lyrics to
the track that's currently playing; show
a sidebar giving a list of what's
playing next and your history; that is,
what you've played.
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Importing Your CDs into Music
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Pop the CD into your Mac's CD drive. If it
doesn’t have oneg, use an external optical

drive like Apple’s USB SuperDrive. A message
pops up asking you if you want to import the
album into your iTunes library; click Yes.

€ Tue28Sep 7:57p

33 9 = 0 @ 9 3 Q 8 T @ I

On the Silver Mountain

Ritchie Blackmore's Rainbow n

(@ @ =

Added Made for You

& Music € Music

Wax Eclectic
from stone classics to indie
contemporaries.

lan Osborne’s Station

You see the track listing of the album
appear. The spinning circle indicates
which track is currently being copied, while
a green tick next to a track tells you it has

already been copied successfully.

iImported your album, don't
forget to click on the Eject button In
the sidebar or the top-right so you can
store your CD away.

If you have an Apple Music

account, Listen Now is the main
page, offering suggestions of music you
might like and showing what you played
recently. Browse is great for finding new
music, and Radio gives access to
streaming stations.

This is the Listen Now page, your
gateway to the Apple Music
streaming service.

This is the gateway to your Music
social network. Click on it and you
can find out what sounds your friends
are listening to, and discover and enjoy
new music together.

These are the options for your
Library, that is, music you've
installed on your Mac. It can be arranged
into Artists, Albums, or Songs, and there
are sections for music you've recently
added and music videos.

At the top of the Listen Now page is
Top Picks, a series of playlists made
up of tracks chosen for you based on
previous plays, tunes you play a lot, themed
playlists, etc. Scroll left and right for more.

These are your playlists. The top
ones are Smart Playlists, which
add songs automatically according to
rules, and the lower ones are playlists you
build yourself.

This is a round-up of music you've
recently streamed. Scroll this page
up for more suggestions, again based
on previous listens.

Click this link to see a wider range
of music you've recently played.

¥
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Signing Up for Apple Music
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With an Apple Music account, you can stream from 70 A pop-up window appears inviting you to subscribe as
million songs for a set monthly fee. To sign up for an an individual, for £9.99/$9.99/9.99 € after your free trial.
account, click on Listen Now in the left-hand sidebar. You canthen  Click Try it For Free to do so, or See All Plans to choose a

click Try it For Free to learn about and sign up to the service. Family or Student account
b » e @ : : D & a sl
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3 You must then sign using to your Apple ID. Enter your If you've not yet used your Apple ID on the App Store,

Apple ID’s email address, then your password, and then you have to ender payment information as shown. You
click Sign In to proceed to the next step. If you've forgotten then follow the on-screen instructions regarding what kind of
your details, click the Forgot Apple ID or Password? link. music you like. When done, you're ready to start.

Changing or Cancelling Your Subscription

Appla ID Accaount
Edit Subscription
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@ Top 25 Most Played

7 Alarss Morissotle Esze_

" Allson’s masic

If you want to cancel your Apple Music subscription, first On the next page, you're shown your active

of all, click Account in the top bar and select View My subscriptions. Click on Apple Music’s Edit link, and on
Account. You're taken to your account page. Scroll down to the next page, you can change your subscription to a different
Subscriptions (under Settings) and click the Manage link one (individual, family or yearly) or cancel it altogether.




Using Apple Music
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Browse or search for the artist, album, or track to which you
want to listen. Here we're looking at an album. Click Play to
play it in its entirety, or Shuffle to play the tracks in a random order.
Tracks marked with an ‘E’ in a box have explicit lyrics.
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Click the three-dots icon on the right above the tracks for
3 .

a menu. Here you can add the album to a playlist or
create a new one, share it with your friends, like or dislike the
album as a whole, or create a station based on its artist.

More by Lana Del Rey
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Apple Music is all about helping you to find music you
enjoy listening to. When viewing an album, you can scroll
up and other titles by the artist in question are shown. Click on
one to open it in the main window, click the chevron to see more.
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Music controls such as Play and Pause are found at the top
of the window. To identify tracks on an album you especially
like, hover the pointer to the left of a track, and click the heart that
appears. To cancel this, click on the heart a second time.
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Each individual song also has a three-dots icon, offering
a similar menu that applies to that track alone. You can
also play the track by clicking the Play icon that appears when
you hover the mouse/trackpad pointer over it.
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The Browse section offers tracks, artists, albums, and
playlists based on Apple Music editors’ choices and new
releases. It also offers current charts for various countries. The
Radio section lets you listen by station or genre, and more.
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Q News
»9  Stories and Features

The News app is great for getting the important headlines as they break, from
news sources around the world. If you subscribe to Apple News+ you can
read a huge range of magazines and news publications on your Mac, and the
app is customisable too, so you'll always be in the know with world events.
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When you first open the News app, you see a sidebar When you open a news story, if it has a video it can be
and a main window. The sidebar’s Today option is watched within the News app. In the File menu, there's
selected, giving you a range of the day's top stories. Click ona  an option to open the story in Safari. This takes you to the web

story to open it and read it in full. page from which the story was drawn.
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3 The Special Coverage section gives you a selection of In the sidebar section titled ‘Suggested by Siri’, you see
features chosen by Apple’s editors. If you find a story you various subjects the News app thinks might interest you.

particularly like or dislike, use the thumibs up/down icons in the The stories work just like in the other sections; click one to

top-right corner to improve future suggestions. open it, click the chevron in the top-left to go back a page.
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In the File menu is an option called Discover Channels
& Topics. Click it for a range of news sources and
subjects for you to choose from. Click the plus sign in the
corner of any you especially like.
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7 In the top left corner, you can see a search field. Enter

a search term for a subject or source you're interested
In and you're given a list of individual stories and channels,
which write about that subject.
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To save a story for later reading, select Save Story in the
File menu. Click Saved Stories in the sidebar to see the
pages you've saved. To go back to a story you've previously
read, click the History option in the sidebar.
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Scroll down the window for more channels and topics.
Select as many or as few as you like. When you're
finished, click the Done button at the bottom. Your new sources
have been added to your sidebar.
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Scroll up the search results for a list of channels anad
topics relating to the search. Click the plus sign to add
that channel or topic to your sidebar. To remove a channel or
topic, right-click on it and then select Unfollow.

Shared with You.

You can share News articles using the macOS Share
icon. If someone shares a story with you using
Messages, it appears in a sidebar category called
Shared with You. The person who shared it is indicated
under each shared story.
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Photos
Manage Your Images

Monterey sees minor updates to the Photos
app. Memories has a new look, and you can
use Apple Music for background tunes. The
information panel is more comprehensive, and
facial recognition is improved. The interface

has been tweaked t0o0.

Use this button to toggle
between regular thumbnails of
your photos, as seen here, and
square-shaped images that leave
little border:

This slider increases and
decreases the size of your
preview images.

3 Use these buttons to view your

photos arranged according to
the year, month, or day in which they
were taken.

Click here to see all your
photographs in the Photos
app, arranged as thumbnails.
Double-click on a thumbnail to
open a photo.

Select or open a photo ana
then click the ‘I’ for the
information window. Here you can
review and edit where and when it
was taken, add captions and more.

The Share button lets you add
the picture to shared albums,
send it using Mail, AirDrop,
Messages and more, add it to Notes
or Reminders and even set a
desktop picture.

= Choose a photo and click the
heart to identify a picture as
one of your favourites.

Rotate the image 90%

anti-clockwise. Hold Alt to turn
it clockwise instead. Useful if a
picture that’s been imported is not
the right way up.

The search field. Thanks to the
Photo app’s machine learning,
you can search for terms like ‘birthday’,
‘holiday’, ‘Christmas’ and more, to find
photos taken on these occasions.

Filter to display all pictures,
favourites, those you've edited,
only photos, only videos and
according to keywords.

Click to switch between

showing only your photos,
and both your own pics and those
shared with you.

These sidebar options
represent different ways of
viewing photos found in your library.
Photos shows all your photos,
Memories arranges them into
groups, Favourites shows your best
pics, and Places groups them
according to where they were taken.
Recents, Imports and Recently
Deleted are self-explanatory.

These are the dates between
which the currently visible
pictures were taken and the locations.

T —————————————

@ Photos File Edit

Photos
Library
%) Memories
® People
J, Places
) Favourites
@) Recents
] Imports
i Recently Deleted

Albums

] Media Types
15 =
16 &) Shared Albums

17

] My Albums

Projects

18 ) My Projects

Image




The heart seen in the
corner here shows
you've identified this photo as
a favourite. Click the heart to
unfavourite it again.

Click here to arrange
and view your media
according to type, such as
Videos, Selfies, Live Photos,
Screenshots and more.

MacBook
;. 2 =

Click the chevron to
expand the Shared
Albums category. Photos
you've shared on iCloud are
listed in Activity, and Shared
Albums shows the albums in
which they were shared.
Hover over Shared Albums
and click the plus sign that
appears to the right to start a
new, shared album.

All Photos

17 These are your albums,
whether created by

yourself or put together

automatically by the app.

If you make a book,

calendar, card, print,
wall decor or slideshow based
on your photos, they appear
here. Apple no longer sells
prints, but you can get apps

Q

Filter By: All Items v

© Mon 27 Sep 3:22 pm

P
I —
L

Photos | &

from the App Store for
third-party services. Hover over
My Projects and click the plus
sign to start a new project.

19 Your pictures, arranged

as thumbnails. Click on
one to open it, after which you
can swipe through them or
choose one from the preview
bar under an open photo.

I‘_ -

- 88
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The Editing Tools Edit With

Right-click on an open photo and you get a sub-menu.
Hover over Edit With and, if you have third-party photo
editors on your Mac, you can open the photo in one of
them and then edit it using that app. Edits are carried
over into the Photos app.

Gat Infa

- Shawt in All Photos

: Rotaie Clockwise
; *-"i"q}-z Rewert to Orginal

Open a photo and click Edit. Use the Wand tool to
automatically enhance your pic or click the Edit button to
make manual adjustments. In Editing Mode, the Edit button
changes to ‘Done’. Click this when you've finished your edits.

Filters

Click a triangle in the sidebar to open a tool. The 3 Retouch removes unwanted objects from a picture.
Light, Colour and Black & White tools give you sliders Click the brush, then click and drag to paint over the
to increase or reduce the brightness and saturation or object. Let go and it's removed. Red Eye lets you paint out
switch to a monochrome image. Click the Options triangles red pupils caused by camera flash. You can adjust the
for more advanced editing tools. brush size with both tools.

In White Balance, select the feature to adjust with the In Curves, drag the diagonal line or the dots under the
pull-down and use the slider to change it. Levels take right and left ends. A useful trick is to click on the left
time to master. Hover your pointer over the graph and drag the dropper and click something black, then the right dropper and
dots at the foot of the vertical lines to adjust. click on something white. The Definition tool is another slider.




lets you make adjustments to one colour at a time, using the
pickers and sliders and Noise Reduction is for smoothing out
speckles and other such imperfections in the photo.

Dramatic ‘Warm 100

Select the Filters tab and you can automatically add
an effect to your photo. Here we've gone for Vivid
Warm but you can also set it cooler, make it monotone and
more. Choosing another filter overrides the last one. Choose
Original to remove all filters.

T @ ¥ O % F W L ¥ U WIS

Edits made in the Photos app are non-destructive, so your
edits can be reversed. If you don't like your edits, click
Reset Adjustments in the bottom right corner to reverse the last
edit, or Revert to Original in the top left to erase all the edlits.

Selective Colour and Noise Reduction are sliders. The former

7 The Sharpen tool lets you sharpen pictures that are out of
focus. You can sharpen the edges, adjust the intensity and

more. The Vignette option lets you add an adjustable shadow to

the edges of the photograph, as you can see we've done here.

You can the Crop tab to rotate your photo if it isn't
looking straight and also to crop it by dragging the
corners into the photo. The Flip option in the sidebar mirrors
the pic and Aspect lets you resize the photo according to
an aspect ratio of your choice.

Universal Tools.

All the options in Edit Mode have these three tools,
which appear when you hover over or open one of the
settings tools. The curly arrow reverses the last
adjustment you made. Auto makes an automatic
enhancement with that tool only and the tick in a circle
toggles the last edit you did on and off, so you can see
the difference it has made.
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Adding People
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Open a photo containing people and click the ‘I' button
for the information window, and click the Add Faces
link. If Photos recognises faces in the picture, they're circled.
Click the tag under a circle to add that person’'s name. Click
the Plus sign again to add further tags, which you can drag
into place as needed.

Projects
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You can still order prints and design books, calendars
and cards with Photos but Apple no longer sells them.
Instead, click ‘“+" next to Projects and select the project you
want to start. Apps you have downloaded for the purpose are
shown, as is an App Store link taking you to extensions
offering these third-party services.

Memories
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Click on Memories in the sidebar to show photos
grouped according to various factors, including time
and content. For example, a series of pictures taken over a
week in a certain location might be identified as a holiday.
Photos also picks your best shots too.
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Click ‘People’ in the sidebar to see photos you've
identified by name. Click on a person to see all the
photos you have of them. If a photo doesn’t contain that
person, right-click on it and select the option ‘X is not in this
photo’ to remove it. Scroll down and click Confirm Additional
Photos to check pics the app thinks are of that person.

L BN Print and publish your photos

Photos for macQS lets you do more than just collect, edit and organise your pictures,
Using Photos extensions, you can create printed projects like books, calendars and
cards

To install an extension, download its cormesponding app (see the list below) from the Mac
App Store, The next time you launch Photos, go to File > Create to see the new opltions
available

o Fhotos

Choose an extension offering the project you want and
install it. Then choose the pictures you want to import
into the project (hold cmd and click on them one by one),
then select the extension in the menu shown in the previous
step. You can then follow the instructions offered on-screen to
build and print your project.
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Open a memory and hover over the picture at the top to
see a Play button. Click it for a slideshow. Hover over
the slideshow for controls. Click the cog to change the
background music. Right-click on a memory and you can
delete it or add it to your favourites.




Photos

Making New Albums Editing Photo Information
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Time Zone: British Summer Time
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On the pictures you want to make into an album, Open a photo and click on the I" icon in the top bar to
cmd-click then hover over My Albums in the sidebar. open the information window. You can add a title,
Click the plus sign that appears and choose whether to make  caption, key words and more here. You can also click on the
a regular album, a smart album or a folder from your pictures.  date and time that it was taken to open a second window.

. Adjust date and time of 1 selected photo

The ariginal date and time of your phots (2 shown Below. Adjust
it to the correct time.

Original:
Adjusted: 28/08 EDERL 4:15:42 pm o

Smart Album Mame: | Untitlad Smart Album
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hidden
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RAW
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Time Lone: India Standard Tima

Closest City: Ahmedabad - india [~ ]

Cancel Adjust \

If you choose a smart album, you can set rules. From You can now close the information window. In the new
then on, any photo you add to your Photos app that Adjust date and time’ window, you can change the
satisfies these rules is automatically added to your smart recorded date and time it was taken and the location, by clicking
album. Set its title in this window too. another point on the map. Click the Adjust button when done.
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3 Choose a regular album and you can give it a name.

The new album appears in your sidebar; click the
triangle next to My Albums to see them all. You can drag
photos onto this album to add them to it.
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2 Glossary of Mac and
Computing Terms

We've tried to keep this guide as jargon free as possible, but inevitably there
are some words and phrases that might still seem mysterious to the newcomer.
Where that's the case, this glossary should help. If you're confused by a
technical term, take a look; you might just find the definition you need in here.

A

Accessibility: A series of tools
and features designed to
make an Apple device such
as the Mac and mobile
devices easier to use by
those with disabilities such
as vision or hearing
impairments. You can find
the Mac’s Accessibility

features and customise them

in System Preferences.
AirPlay: A protocol for

streaming sounds and video

from an Apple device to a

set of compatible speakers,

or a device such as an
Apple TV. It's wireless, and

easy to use as well.

AirTag: A small Bluetooth
device that can be tracked
using the Find My app. It's
used to locate property like
keys or luggage.

App: Short for ‘application’,
another name for a

computer software program.

Your Mac comes with a
selection of pre-installed

apps, and you can buy more

from the Mac App Store.
App Store: The App Store is

where you can download free

and paid programs to your
device using your Apple ID.

You can access it through the

application that comes
bundled with your Mac.

Apple ID: This is the email

address and password that

you have registered with
Apple. It's required to
access many online
applications on your Mac,
including iTunes, App
Store and Books.

Apple Menu: The menu that's
opened by clicking on the
Apple icon in the left of the

menu bar. It gives access to
system functions such as

Preferences, App Store,
Force Quit and more.

Apple Silicon: Apple’s new
series of processors, used
in the latest Macs. They
replace the older, Intel
CPUs previously used.

Bluetooth: Bluetooth is a
wireless technology used to
link and exchange data with
another compatible device. It
has a range of approximately
eight metres (25ft). The Mac
supports many Bluetooth
devices, including
headphones, keyboards and
fitness trackers.

Books: This is Apple’s eBook
application, which is
available for free from the
App Store and is also
bundled with recent
versions of macOS. |t
handles the standard
electronic publishing
formats protected by
FairPlay DRM, and also
PDF documents. It was

introduced in 2010 along
with the iPad.

Browser: An app used to
access websites found on
the worldwide web. The
Mac comes with Apple’s
Safari browser preinstalled,
but others are available in
the App Store.

C

Calendar: This is one of Apple’s
preloaded apps. Use it to
keep track of events,
invitations, and reminders
on your Mac, iPhone, iPod
touch and iPad.

Closed Clamshell Mode: By

connecting your notebook
Mac to a display, an external
keyboard and a controller
such as a mouse or Magic
Trackpad, you can use it like
a desktop computer, with the
notebook closed.

D

Desktop: A computer that's

designed to be used on a desk
while plugged into the mains, at
home or in the office, as
opposed to a notebook or
laptop. Apple’s range of
desktop computers is the iIMac,
the Mac mini and the Mac Pro.

Dock: The opaque strip at the

bottom of the screen. Apps
in the dock are easy to
access and open, and you
can customise it to best suit
your requirements. Apps
that are currently running
are also shown in the dock.

E

Emoticon: A small drawing

used to augment a message
or text. Typically, these are
yellow faces showing a
variety of expressions.

Facebook: Currently the most

popular social networking
site on the Internet. Add
your Facebook account to
your list of Internet Accounts
in System Preferences and
you can share material
directly to it using the
macOS Share button.

FaceTime: You can make video

and audio calls to other Apple
devices using the FaceTime
app. These are made over
the Internet so are free

unless using mobile data.

Finder: The Finder is the Mac's
user interface. It deals with
management of folders,
windows, menus and more.
Its feature set has grown over
the years, with recent
introductions including tabbed
Finder windows and tags.

Folders: A folder is a container
for a group of apps or files.
You can create one by
using Finder’s File menu, or
right-clicking on the desktop
and using the contextual
menu. You can drag items
into and out of a folder.

Force Quit: The act of forcing
an application to close
down, perhaps because it's
crashed or frozen. It's
achieved by right-clicking its
dock icon, or opening the
Apple menu and selecting
Force Quit. Unfortunately,
unsaved work will be lost.

G

Gestures: These are actions
performed with your fingers
on the Mac's trackpad.

You can use gestures on a
notebook trackpad, an
Apple Magic Trackpad or to
a limited extent, an Apple
Magic Mouse.

Gumdrops: A colloquial term for
the three coloured buttons
found in the top left corner of
an app or finder window.
They close the window (red),
minimise the window (yellow)
or switch to and from
full-screen mode (green)

H

HTML: Hypertext Markup
Language, the standard for
building websites, and a
cornerstone technology of
the worldwide web.




iICloud: The collective name for
Apple’s online services, it
replaced MobileMe and
integrates with all iOS/
IPadOS and macOS/0OS X
Mac computers.

iIMessage: A text message
that’s sent from one Apple
device to another.
iIMessages use the Internet
rather than the mobile
phone network, so they're
sent free of charge from
iIPhones and iPads.

I0S: Apple’s mobile operating
system. iOS is the software
that powers the iPhone, iPod
touch, iPad and Apple TV.

iPadOS: The latest operating
system used by the iPad. It
evolved from iOS.

iTunes: Apple's abandoned
music playing software,
which was also used to
activate and sync iPads and
IOS devices. In macOS
Catalina, iTunes was
replaced by three new apps;
Music, TV and Podcasts.

L

LaunchPad: Found in the dock
represented by a rocket
icon, the LaunchPad is an
easy way of opening apps.
It resembles and behaves
like an iOS Home screen.

Lightning: The cable connection
used by modern iPads and
IPhones. It replaces the old
30-pin dock connectors, and
is used to charge these
mobile devices and sync
them with your Mac.

Location Services: Features
and software on your Mac
that pinpoint and use your
current location. The Maps
app is one example.

macOS: Formerly known as

OS X, macOS is the
operating system on which
the Mac runs. The current
version of macOS is
Monterey. Like most recent
versions of macOS,
Monterey is a free upgrade.

Mail: The Mac's bundled email
client. It can handle a wide
range of email accounts,
including Apple iCloud
accounts, Microsoft’s and
Google’s mail services,
Yahoo email accounts and
those accounts that are
provided by your Internet
Service Provider. Third party
email apps are available.

Menu Bar: The macOS Menu
Bar sits atop the desktop, at
the top of the screen. On
the left are pull-down

menus, which vary
according to what app
you're using. On the right
are menulets and controls,
along with info such as the
time and date.

Messages: One of Apple’s
built-in apps that handles
SMS text messages and
MMS multimedia messages.

MMS: Multimedia Messages
(MMS) supports images,
videos, sound, contact
cards, and location data.
Sent and received via the
Messages app on the Mac
to other Macs and mobile
cell phones.

Monitor: Also called a display,
this is an external screen
that's essential for Mac
minis and Mac Pros. You
can also add a monitor to
an iMac or notebook Mac
as a second or even
primary display.

Mouse: A controller used to
move your pointer around
your Mac’s screen, and to
select options using the
mouse buttons. A mouse is
traditionally used with a
desktop computer such as
the iMac or Mac Pro, but if
you don't like trackpads,
you can use one with your
notebook too.

N

Notebook: A portable computer,
sometimes called a laptop.
Notebooks can be mains or
battery powered and have
their own built-in screen,
which folds down for
portability. Apple’s notebook
range includes of the
MacBook, MacBook Air and
MacBook Pro.

Notification Centre: A list of
recent notifications,
accessible by clicking on
the icon in the top-right
corner of the Mac’s desktop.

P

Photo Stream: Part of iCloud,
Photo Stream stores your
last thirty days or 1000
photos online and on your
iI0S/iPadOS devices, and all
your photos on your Mac.

Photos: A bundled Mac
application that lets you
store, manage and edit your
photo collections and share
them with your other Apple
devices using iCloud.

Q

QuickTime: Apple’s 2D video
and graphics player, used to
play movies and other video
on your Mac.
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Retina Display: This is Apple’s
term for its high-resolution
screens. The pixels are so
small it's impossible to
distinguish between them at
a normal viewing distance,
making the on-screen images
very smooth and clear.

Right Click: On a two-button
mouse, a right-click is a click
with the right-hand mouse
button instead of the left. On
a Mac, with a trackpad or
Magic Mouse, a right-click is
achieved by holding the
Control button and clicking,
or setting up the device so a
two-fingered click or a click
on the right-hand side of the
Magic Mouse or Trackpad
delivers a right-click.

S

Safari: Apple's web browser,
similar in function to
Microsoft Explorer or Google
Chrome. It's available for
both Macs and iI0S/iPadOS
devices, and it lets you surf
the worldwide web.

SharePlay: A feature that lets
you share movies and
music while in a FaceTime
chat. All parties in the chat
enjoy the same media,
which is played in sync so
no one’'s a few seconds
ahead or behind.

Siri: Apple’s voice activated
digital assistant. You can
give Siri spoken instructions
and the service replies by
giving you the information
you asked for; or by
activating the requested
Mac function.

SMS (Short Message Service):
Text messages sent from
the Messages app from a
Mac's Messages app or
mobile device such as the
iIPad or iPhone to other cell
mobile phones.

T

Tablet: A computer in a flat,
‘tablet’ form factor, such as
the iPad. While the iPad is the
most popular tablet computer,
other models are available.

Text Field: Any area of the
screen where you can add
text. For example, when
completing a web form, there
are text fields for things like
your name, address and
more. Tap on a text field to
bring up the cursor, so you
can start typing.

Thunderbolt: A high-speed
connectivity port offered on
recent Macs. A Thunderbolt
port can carry a video signal
as well as data, so it can be
used for an external display.

Touch Bar: The very latest
models of the MacBook Pro
replaces the function keys
with a touch-sensitive
screen which displays
functions and controls
according to the app or
feature you're currently
using. It also has a Touch
ID fingerprint scanner for
unlocking your Mac.

Trackpad: The controller device
used in notebook Macs. You
control your on-screen pointer
by dragging your finger across
the trackpad. Apple's Magic
Trackpad is available for
desktop computers.

Twitter: One of the most
popular social networks
built around a follower/
following system rather
than friends, with
messages limited to 280
characters. There's an
official Twitter app for the
Mac, and several third
party options for sending
Tweets too.

U

URL: Uniform Resource
Locator, the address used
to access a web page. For
example, Apple’s URL (its
website) is www.apple.com.

USB: (Universal Serial Bus) an
industry standard for
connecting computers and
peripherals introduced in the
mid-Nineties. The latest
version, USB-C, has a
similar plug to Thunderbolt
3, and is compatible with
Thunderbolt 3 ports.

Vv

VPN: (Virtual Private Network):
This provides secure access
over the Intemet to private
networks, such as the network
at your company or school.

W

Wi-Fi: A wireless means of
getting onto the Internet or
connecting two devices. At
home, your Wi-Fi network is
established through your
router. Whilst away from
home, you might have
access to public Wi-Fi
networks like those offered
in coffee shops or libraries.

Y

YouTube: The Internet’'s most
popular video viewing and
sharing service. Owned by
Google, you can access
YouTube through a web
browser, or through a
dedicated app available for
the Mac, iPhone, iPad or
iPod Touch.
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